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INTRODUCTION TO SYSTEM 2000 SOFTWARE

The Dycor System 2000 software provides a graphical user interface to control 
your RGA data. Running under Windows 98 or NT, OR Windows XP, it provides 
powerful features and flexible operating modes. 

Minimum PC Requirements for System 2000 Software

System 2000 Software requires the following:

• Pentium  300 CPU or better

• 32 MB RAM for Windows 98, 64 MB RAM for Windows NT 128 MB RAM 
for Windows 2000 and XP

• 3 MB disk space

• Sound Card (for Leak mode tone and alarms). Recommended, not required.

• Microsoft Windows 98, NT 4.0 2000 or XP

• 640 x 480, 256-color display.

 For optimum display quality we recommend running at 800x600 or 
1024x768, High Color (16-bit). 

To change your display resolution or color palette:

• On the Windows Control Panel, click Display Properties.

• Click the Settings tab.

• Under Color Palette, click High Color (16-bit).

• Under Desktop Area , set 800 x 600 pixels or more.

Dycor System 2000 Software Installation
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1. Insert System 2000 software CD into CD ROM  drive.

2. The installation program should begin to run immediately. If it does not start 
automatically, click RUN... from the Windows Start menu. Type the drive 
letter, followed by a colon ( : ) and a backslash (\) and the word “setup.exe” 
(d:\setup.exe) and click OK to start the installation program.

3. The Dycor Process 2000 setup begins and the Welcome screen opens. Click 
Next to continue the installation or Cancel to abort the installation.

4. Follow the instructions on the subsequent screens to complete the installa-
tion. When you get to the Setup Complete screen, click Finish to complete 
the installation. The default location for the System 2000 software is in the 
Dycor System 2000 folder.

 

Instructions For Using Dycor System 2000 Software

Follow the instructions below to configure the Dycor System 2000 Software on 
your system to obtain RGA and other input data. Make sure that you have already 
correctly set up the appropriate hardware. See your device hardware manual for 
information on hardware setup.

1. Start the Dycor System 2000 Software.
• Click the Windows Start button, then click Programs and Dycor System 

2000. If you did not choose the default options during installation, the paths 
or names could have changed. Another option is to use the file manager 
program to look for the Dycor 2000 subdirectory and to activate the Dycor.
exe executable program.

2. Add a Device. 
 Devices include quadrupole heads and analog or digital inputs. 

• On the Edit menu, click Add Device.

3. Set Device Settings. 
 Communications settings, tune and filament protection parameters and device 

type.
• Communications settings include whether the system is running on a single 

head (RS-232) or multiple heads (RS-485).

4. Select a Display Mode.
 Analog
 Bar
 Trend
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Tabular
Meter
Annunciator
Leak

5. Define Scan Settings.
Move the mouse to the display. Right-click the display. Click Scan and de-
fine the following:

• Device to be scanned,
• Mass or range of masses to be scanned,
• Number of samples for each scanned value, and
• Dwell time.

6. Set Up Display Parameters.
You can create your own custom displays through Custom modes. These can
be saved for retrieval later. Three default custom modes are provided to make
it easier to create and save custom scan, display, alarm and analog output
settings. Different options are provided within each mode. You also have the
option of linking data and including calculations based on linked data.

7. Set Up Alarms. (optional)
Includes the ability to have a master alarm that triggers based on a variety of
other alarm conditions using Boolean logic.

8. Set Up Analog Outputs. (optional)
9. Schedule Scans.

Scan continuously or schedule scans to be performed at timed intervals.

10. Start Scanning.

11. Save Scanned Data for Later Viewing or Printing. (optional)

12. Include Scripts to Automate Dycor Processes. (optional)
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Figure 2-1.
Dycor System 2000 
screen

 USER INTERFACE / SETTING UP DEVICES

The Dycor System 2000 screen allows you to customize how data is viewed and 
how otherwise to set up your display.

The View Menu

From the View Menu select the menu option for the viewing area you want 
displayed. If the option has a checkmark beside it, the viewing area is active. To 
toggle the on/off checkmark, select the menu option again. Toolbars displayed on 
the Main Window include:

•	 Standard Toolbar
 Icons used most often including the main display modes.

•	 Custom Mode Toolbar
 Icons that are used for the Custom mode.

•	 Data	File	Toolbar
	 Icons	relating	to	saving	data	files.	
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•	 Script Buttons *

	 Creates	a	display	containing	four	buttons.	These	buttons	launch	user-defined	
scripts. Set the scripts by  clicking on the Script menu and then clicking on 
Set Menu.

•	 Status Bar
 Bar at the bottom of the screen that displays system messages including 

whether or not the system is currently scanning.

•	 Devices	&	Log
 Displays a window showing all devices and their status. Also shows the sys-

tem event log.

•	 Library
 Displays the mass spectra library window.

*   System 2000 multi only
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Setting Up Devices

This section includes instructions for setting up both Serial and Ethernet quadru-
pole heads and digital or analog I/O.

Adding a Device / Changing Device Properties

•	 To	add	a	device,	on	the	Edit menu, click Add	Device. The Add	Device dia-
log box opens (Figure 2-2). Click on the appropriate device from the follow-
ing:

•	 Dycor	Dymaxion	-	ETHERNET	Communications
•	 Dycor	Dymaxion	-	SERIAL	Communications
•	 Dycor	Quadlink
•	 Optomux	Digital	*
•	 Optomux	Analog	*
•	 Action	Analog	*

Figure 2-2.
Select device type.


NOTE

Once you select your device, Click OK. The Device	Properties screen opens. 
The Device	Properties	screen	configuration	is	specific	to	the	type	of	device	that	
you have chosen. Figures 2-3a to 2-3e show the Device	Properties	screens for 
the	various	configurations	that	you	can	select.

The number of tabs and elements on the tabs on the Device Proper-
ties screen will change based on the Type of device that you select 
(Dymaxion (Serial/Ethernet), Quadlink, Optomux Digital or Analog 
and Action Analog). Be sure to select your correct device type to 
view the correct tabs.

*  Multi systems only.
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Figure 2-3a.
Ethernet Dymaxion 
Device Properties 
window.

Figure 2-3b.
Serial Dymaxion 
Device Properties 
window.

Figure 2-3c.
Quadlink Device 
Properties window.
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Figure 2-3d.
Digital I/O Dymaxion 
Device Properties 
window.

Figure 2-3e.
Analog I/O Dymaxion 
Device Properties 
window.

• To	change	device	properties,	on	the	Edit menu, click Device	Properties
(Figure 2-4a). When changing the properties of an existing device, click that
device in the Select	a	device	to	edit box (Figure 2-4b).

Figure 2-4a.
Select Device 
Properties on the Edit 
menu.

Figure 2-4b.
Select a device to edit.
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Serial Communication Devices

General tab
The device description and attributes (AMU/Faraday/Multiplier) and any I/O 
capabilities are displayed in the upper right-hand corner of the screen.

•	 Communications 
 	Port	 Select the COM port on the computer used to connect to 

your device.

  Address   Type the network address of the device.

  Bits per Second  Baud rate at which data will be transferred.

  RS-232	Port		 Click	if	using	the	RS-232 communications port.

  RS-485	Port	 Click	if	using	the	RS	485	communications	port.

•	 Device	
  Name  Provides a name for the device. Used when printing or display-

ing information for the device.

  Description	 Enter a description of your device.

		Type			 Device type is displayed.

•	 Device	Enabled
Not Checked  System temporarily ignores the device.
Checked Device is available for use by the system.

•	 Live	Data
Not Checked   System uses demonstration data.
Checked  System uses live data.

Figure 2-5a.
Device Properties 
dialog box - General 
tab - Serial Dymaxion.
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Ethernet Communications Dymaxion

General tab
The Ethernet Dymaxion uses Ethernet communications to connect to the PC. 
Multiple	analyzers	can	be	connected	using	a	Local	Area	Network	(LAN).	If	you	
have selected Dymaxion	-	ETHERNET	Communications as your device type, 
the	following	properties	are	defined	for	the	Ethernet	Dymaxion	devices	using	the	
General tab	(Figure	2-5b).

• Available Dymaxion  A listing of all of the Dymaxions that are
Devices available on the network.

Name	 The	device	name	is	automatically	entered.	This	can	
be changed.

ID	 This	is	a	unique	identifier	that	consists	of	4	num-
bers or letters in the form “1A-2B”. This cannot be 
changed	by	the	user.	This	identifies	the	actual	physi-
cal Dymaxion.

The only time that the ID changes is if the Master board in the elec-
tronics unit changes.

IP	 The	IP	is	either	set	automatically	or	configured	us-
ing the Setup button.

Once you add a device from the available list using Add Device on 
the Edit menu, it is removed from the list of “Available Devices.”

Figure 2-5b.
Device Properties 
dialog box - General 
tab - Ethernet 
Dymaxion.
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Setup button

The Setup button displays the default IP address and method of connection for 
the	selected	device.	If	your	system	supports	Dynamic	Host	Configuration	Pro-
tocol	(DHCP),	you	do	not	have	to	configure	your	communication setup (Figure 
2-6a).	If	your	system	does	not	support	DHCP,	an	IP	address	is	assigned	to	the	
Dymaxion when you click Static	IP (Figure 2-6b).

Figure 2-6a.
Setup Screen. IP 
address automatically 
assigned by local 
network.

Figure 2-6b.
Setup Screen. 
Static IP. IP address 
manually assigned.

If there is more than one Dymaxion on the network, a checkbox 
displays to the left of each name. Click the checkbox to select the 
Dymaxion. If there is only one device available, it is selected auto-
matically and no checkbox displays.

Search Network button

This button is used to search for Dymaxions on the 
network.	It	takes	approximately	five	seconds.	When	
System 2000 starts up, the program automatically 
searches for Dymaxions on the network. If you add 
a new Dymaxion and it does not appear in the list of 
available devices, refresh the list using the Search 
Network button.
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Connecting the Ethernet Dymaxion

If the Dymaxion is set to Automatic IP Address and used on a corpo-
rate network that assigns addresses using a DHCP server, the net-
work cable must be plugged into the Dymaxion before it is powered 
up.

1. If the Dymaxion is powered up before the network cable is plugged in, the 
Dymaxion	will	assign	itself	an	IP	address	in	the	form	169.254.xxx.yyy.	The	
xxx and yyy will be random numbers. If this happens, you may see it listed 
as an available device in the Device Properties dialog box, but it will remain 
off-line and unable to communicate.

2. You must remove power to the Dymaxion and then, making sure that the 
network cable is plugged into the Dymaxion, restore power. This will force 
the	Dymaxion	to	get	an	address	from	the	DHCP	server.	See	“LAN without 
DHCP” section of this manual to ensure there is only one network enabled 
when connecting the Ethernet Dymaxion..
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Ethernet Dymaxion 
Direct Communication Connection

Ethernet Cross-Over Cable

Use this communications setup when there is no LAN.

If you are using a direct cable connection, your PC must be running 
for at least one minute before starting the System 2000 software.

Connect the Dymaxion directly to the PC using either the Ethernet crossover 
cable provided with your analyzer or by using an Ethernet hub.

1. Run	the	Dycor	System	2000	software	by	clicking	the	icon	on	your	desktop	or
by clicking the Windows Start button, Programs, and then Dycor	System
2000.

2. On the Edit menu, click Add	Device. The Add	Device dialog box opens. Se-
lect your device by clicking it, then click OK. The Device	Properties screen
opens	(Figure	2-5b).	If	more	than	one	device	is	available,	they	will	be	listed
in the Available	Dymaxion	Devices box. Select your device by clicking the
checkbox to the left of the device. If only one device is available, it will auto-
matically be selected.

If your device does not appear in the Available Dymaxion Devices 
box, click the Search Network button to refresh the list.  

3. Click OK to close the Device	Properties dialog box and complete the com-
munications setup procedure.

If your device does not appear in the Available	Dymaxion	Devices box, check 
the cable connection.
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LAN without Dynamic Host Configuration Protocol (DHCP)

You can have only one network connection enabled to connect the 
Ethernet Dymaxion. For example, if you have a wireless network 
enabled, you must disable it before establishing communication with 
the analyzer.

If	you	are	unsure	which	networks	on	the	LAN	are	enabled,	check	using	the	fol-
lowing procedure based on Windows® XP.  Your procedure may differ based on 
which version of Windows® you are using.

1. Click Start , Control	Panel, Network Connections. Disable all networks 
not connected to the Dymaxion, e.g., wireless, by right clicking on the selec-
tion and selecting “Disable”. This ensures that only the network to which the 
Dymaxion is connected is enabled.

2.	 Establish	the	LAN	connection	to	the	Dymaxion	as	described	below	using	
under “Communication Setup.”

If you re-enable your other network connections after the Ethernet 
Dymaxion establishes communication, those enabled networks must 
be again disabled any time you need to re-connect the analyzer after 
a disconnection.

If your network does not support DHCP, the analyzer will automati-
cally assign itself a unique IP address. This IP address will be on a 
different subnet than your PC and so you will have to set up com-
munications between the System 2000 software and the Dymaxion 
manually.

Communication Setup
1. Contact your IT department to get a unique IP address on the same subnet as 

your PC.

2.	 Run	the	Dycor	System	2000	software	by	clicking	the	icon	on	your	desktop	or	
by clicking the Windows Start button, Programs, and then Dycor	System	
2000.

 Sometimes, due to network congestion, the Dymaxion devices will have an 
“Offline”	or	“Busy”	status	when	the	System	2000	starts.	

- Click the View menu and select Devices	and	Log to see if there is a 
Transmit error message in the system log.
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- Assuming the Dymaxions are still connected to the network and run-
ning, the System 2000 software will keep trying and should connect
eventually. This could take one to two minutes.

3. On the Edit menu, click Add	Device. The Add	Device dialog box opens. Se-
lect your device by clicking it, then click OK. The Device	Properties screen
opens	(Figure	2-5b).	If	more	than	one	device	is	available,	they	will	be	listed
in the Available	Dymaxion	Devices box. Select your device by clicking the
checkbox to the left of the device. If only one device is available, it will auto-
matically be selected.

The IP address that is next to the device must be changed to establish com-
munication.

If your device does not appear in the Available Dymaxion Devices 
box, click the Search Network button to refresh the list.  

Device is Not Listed in Available Dymaxion Devices

• Check	the	Ethernet	connection	between	the	Dymaxion	and	the	LAN.

• Check	to	make	sure	that	the	PC	is	running	on	the	same	LAN	segment	as	the
Dymaxion.	This	can	happen	if	the	PC	is	on	a	LAN	connected	to	another	LAN	via
a	network	router.	It	can	also	happen	if	the	PC	is	connected	to	the	LAN	through	a
VPN	connection.	If	this	is	the	case,	System	2000	cannot	see	any	Dymaxion	on	the
network using the Search Network button.

- Connect	the	PC	to	the	same	LAN	segment	and	then	add	and	configure
all of the devices. The device list, Dymaxion ID and IP Address are all
saved	in	the	dycor.dys	file	in	the	Dycor2000	folder.

- Copy	this	file	to	the	PC	on	the	other	LAN	segment.	The	PC	will	now
have the device setup and will be able to communicate.

4. Click the Setup button to access the Setup	IP	Address dialog box (Figure
2-6b).

5. Click	Static	IP. In the IP	Address	box, type in the IP address that you ob-
tained for the Dymaxion.

6. Click OK to accept the address.

It will take a few seconds for the Dymaxion to set the new IP address.
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Status: Busy

If a Dymaxion on the network is already being accessed by a user and another 
user tries to connect from another PC, the Dymaxion will report as “Busy” under 
Status on the Devices	and	Log	window.	As	soon	as	the	first	user	is	no	longer	
connected to the Dymaxion, the Dymaxion will be available for the other user 
and the Status will change to “Online”.

If the Dymaxion is turned off, or the network cable unplugged, while 
the System 2000 software is running, the System 2000 software may 
appear to “freeze.” This is most likely to happen when clicking OK 
in Device Properties or when exiting the program. Be patient . . . the 
program may take up to a minute to run again.
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Tune Parameters Tab

Figure 2-7.
Device Properties 
dialog box - Tune 
Parameters  tab.

Tune	File

The	Tune	Parameters	are	stored	in	battery-backed	RAM	inside	the	electron-
ics unit. When the System 2000 software starts, it immediately reads these 
tune	parameters	that	were	stored	at	the	factory.	The	.tun	file	generated	now	
becomes	the	back-up	file	of	these	values.	It	is	still	possible	to	recall	a	saved	
.tun	file	by	using	the	Browse button. 

Browse Button 

Save	Button 

Head	Type	

Retrieves	a	previously	saved	tune	file.	Navigate	to	the	loca-
tion	of	the	file	and	double-click	it.	Click	the	Apply	button 
to use the stored parameters.

Saves	current	tune	parameters	to	a	tune	file (default exten-
sion .tun).  These settings can be imported later using the 
Tune	File text box or using the Browse button.

Configures	the	analyzer	head	to	be	correctly	identified	by	
the unit.
Ion Sources Select Open or Closed
Filament Standard (yttria coated iridium) or 
Tungsten Multiplier Standard or V-Stack

Emission Current
This is the electron emission current used to ionize molecules in the ion 
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source.	This	parameter	adjusts	the	filament	power	until	the	actual	electron	
current equals this value. 1E-3 Amps (1 mA) is the best choice for medium 
pressure work. If this value is changed, the sensitivity of the analyzer will 
change and you should recalibrate the analyzer.

 Range: 1E-4 to 1E-2 amps (.1 to 10 ma.)

Electron	Energy
 Energy of the ionizing electrons in the ion source. It is measured in electron-

volts	(the	difference	in	potential	between	the	filament	and	the	source	grid).	
Most	data	available	on	ionization	efficiencies	and	cracking	patterns	of	vari-
ous molecules are taken at -70 volts and you will rarely have to change this 
parameter.	During	a	degas	operation	this	voltage	will	increase	to	-250	volts	
until the degas is complete.

 Range: -150 to -30 volts

Focus	Voltage
	 Normally	set	to	-20	volts.	You	can	get	a	slight	increase	in	sensitivity	by	

adjusting this voltage, but severe mass discrimination can occur at extreme 
limits.

 Range: -200 to +10 volts

Repeller	Voltage	 (Non-CIS Head)
 This parameter sets the voltage on the repeller grid that surrounds the ionizer. 

It is normally set a few volts above the Electron	Energy parameter so the 
electrons are contained within the ionizer. It should never be set positive with 
respect	to	the	filament.	This	parameter	is	normally	set	to	minus	72	volts	when	
the Electron Energy parameter is set to -70 volts.

 Range: -200 to +10 volts

CIS	Lens	Voltage (Displayed if using a CIS head)
	 This	is	an	additional	focusing	lens	used	in	Conductance	Limited	Ion	Source	

(CIS) heads.
 Range: -200 to +10 volts

Frequency * 
	 RF	frequency	applied	to	the	mass	filter.	Should	be	adjusted	so	the	RF	Tune	

Value is minimized within its typical operating range. Frequency parameter 
should	be	adjusted	up	or	down	until	the	RF	Tune	Value	is	minimized.	Nor-
mally use the Auto Tune.

 Range: 1.000 to 3.000 MHz

Cal low Mass*
	 Normally	keep	this	value	set	to	1.	At	the	low	mass,	the	low	position,	low	

sensitivity and low resolution calibration values will be used.
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 Range: 1 to 100

Cal HigH Mass*
 Set to 100 or 200 depending on whether the device has a 100- or 200- AMU 

range. At the high mass, the high position, high sensitivity and high resolu-
tion calibration values will be used.

 Range: 1 to 200

Low	Position
 Used to adjust the peak positions at the low end of the scan range so that the 

peaks correspond to their associated AMU values. Increasing this value shifts 
the peaks to the right. Decreasing this value shifts peaks to the left.

 Range: -10 to 10

High	Position
 Used to adjust the peak positions at the high end of the scan range so that the 

peaks correspond to their associated AMU values. Increasing this value shifts 
the peaks to the right. Decreasing this value shifts peaks to the left.

 Range: -10 to 10

Low	Resolution
	 Used	to	adjust	resolution	of	the	peaks	at	the	low	end	of	the	scan	range.	Nor-

mally adjusted for a 10% valley between the peaks of adjacent masses.
 Range: 50 to 4100

High	Resolution
 Used to adjust resolution of the peaks at the intermediate and higher end of 

the	scan	range.	Normally	adjusted	for	a	10%	valley	between	the	peaks	of	
adjacent masses.

 Range: 50 to 4100

Low	Sensitivity

	 This	is	the	ion	energy	(in	electron-volts)	that	the	ions	entering	the	mass	filter	
will have for the low masses. If the energy is increased, the sensitivity will 
increase but the resolution may decrease. Standard setting (6.00) provides 
a partial compensation for the decrease in sensitivity at high masses while 
keeping the best possible resolution.

 Range: 3.00 to 10.00

High	Sensitivity
	 This	is	the	ion	energy	(in	electron-volts)	that	the	ions	entering	the	mass	filter	

will have for the high masses. If the energy is increased, the sensitivity will 
increase but the resolution may decrease. Standard setting (7.00 for 100-
AMU	units	and	8.00	for	200-AMU	units)	provides	a	partial	compensation	
for the decrease in sensitivity at high masses while keeping the best possible 

*   This parameter is automatically set in the Dymaxion,
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resolution.
 Range: 3.00 to 10.00

Amplifier	Calibration
 With Emission Current	set	at	1.0E-3,	an	AMP	CAL	of	5.0E-3	allows	the	

partial pressure readings to be approximated in Torr. This is a gain parameter 
by which each current reading is multiplied. When Amplifier	Calibration is 
set to one, the partial pressure readings are in amps.

 Range: 1.0E-10 to 1.0E10

Total	Sensitivity
 This calibration factor can be set between 0.1 and 999.9. It can be adjusted so 

that the total pressure reading agrees with an ion gauge reading. The number 
is a simple multiple of the measured total current to the Faraday cup when 
reading total pressure.

 Range: .1 to 999.9

Multiplier	Voltage
 Applies only if you have an analyzer with a multiplier (not a Faraday cup). 

This is the multiplier voltage placed on the multiplier. A typical value is 
-1000 volts.

 Range: 0 to -2000 volts

I/O Setup Tab

•	 Dymaxion	I/O
•	 Analog	I/O
•	 Digital	I/O
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 Figure 2-8.
Device Properties 
dialog Box - Dymaxion 
I/O Setup tab - input 
and output

Module Type

Under Type, click on one of the following based on the type of module con-
nected to I/O device.

Empty	 Module is empty and will not be used as a 
system input or output

Analog In (for analog devices) Analog input module

Analog Out (for analog devices) Analog output module

Digital	In (for digital devices) Digital input module

Digital	Out (for digital devices) Digital output module

Temp In (for analog devices) Used for a thermocouple input

Module Name

Define	a	name	for	the	module	to	be	used	when	referencing	the	module	in	the	
Dycor System 2000 Software.

Scripts Tab - only in System 2000 Multi

Runs	a	script	when	a	digital	input	changes	state.	Select	function:
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Disable	All	 No	scripts	will	be	run

Enable	-	Low	to	High	 The script will run when the digital input goes from 
low to high.

Enable	-	High	to	Low	 The script will run when the digital input goes from 
high to low.

Enable	Change	 The script will run when the digital input changes 
(available only on the Dymaxion)

Deleting a Device

1. On the Edit menu, click Delete	Device.
2. Click on the device you want to delete from the list of devices.
3. Click OK
4. The device is deleted.

You cannot delete a device that is currently active. To deactivate the 
device, right-click on the display window containing the device and 
then click Scan. Disable the device in the Data Source section.

Viewing Devices

1. On the View menu, click Devices	&	Log or click on the    icon. A log is 
displayed showing all active devices and their status.
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2.	 Here	it	is	possible	to	view	a	log	of	all	related	activity	for	active	devices,	in-
cluding	when	the	filament	or	multiplier	was	turned	on	or	off	and	when	scans	
were started or completed, as well as any alarm conditions. It also provides 
information on the data source for the reading in the Source field.	The	Status 
field	indicates	whether	live	or	demo	data	is	being	used.	Demo	data	can	be	
used to simulate real data for testing purposes.

3. To remove the log display, on the Edit menu, click View	Devices	&	Log 
again or click on the 		icon.	The	system	log	is	saved	in	a	text	file	in	the	
“log” folder.

4. To toggle the on/off state of any of the viewing areas, click the menu option 
again.
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MODES OF OPERATION

Any setting you defined in a mode will be retained by the system 
when you change the mode or exit the program. Any display or scan 
parameters that you defined for a mode will not be transferred to a 
new mode when you switch modes. However, the system will continue 
to scan when you change modes.

•	 Analog Mode
	 Scan	over	a	range	of	masses	to	view	both	peak	shapes	and	heights.

•	 Bar Mode
 Scan	over	a	range	of	masses	to	view	mass	peaks	and	heights.

•	 Meter Mode 
	 View	the	partial	pressure	of	a	specific	mass	or	digital/analog-compatible	

module	input	in	a	meter-type	format.	Alarms	can	be	set	up	and	displayed	to	
the	right	of	the	meter	to	view	the	current	reading	in	relation	to	the	high-	and	
low-alarm	limits	defined.	For	example,	in	Meter mode,	multiple	meters	can	
be	set	up	with		each	meter	corresponding	to	a	different	mass	from	a	different	
quadrupole	head.

•	 Annunciator Mode 
	 Track	whether	a	measured	parameter	is	within	acceptable	levels	using	a	

simple	color/text	indication.	If	the	level	is	

	 	within	the	alarm	limits	defined		 =		 green  ok

	 	above	the	high-alarm	warning		 =		 yellow HigH

	 	above	the	high-alarm	limit		 =		 red  HigH

	 	below	the	low-alarm	warning	level		 =		 yellow  low	
	 	below	the	low-alarm	limit		 =		 red low

You	can	set	up	multiple	indicators,	each	corresponding	to	a	different	mass	from	a	
different	quadrupole	head.
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•	 Trend	Mode	
	 View	trends	of	selected	masses	or	digital/analog	inputs	over	time.

•	 Tabular Mode 
	 View	information	in	a	textual,	table-type	format.

•	 Leak Check Mode
	 Check	for	leaks	in	the	vacuum	system	by	monitoring	the	level	of	a	selected	

tracer	gas	over	time.	

•	 Custom Mode
	 Create	custom	setups	including	all	scanning,	display,	alarm	and	analog	output	

options.	Custom	mode	setups	can	include	either	a	single	mode	display	or	
multiple	mode	displays.	For	example,	you	can	customize	the	screen	to	show	
one	Analog mode	display,	one	Trend mode	display	and	two	Meter displays.	
Or,	you	could	set	up	two	Analog mode	displays	or	two	Bar mode	displays.

Analog Mode Overview
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Analog mode	allows	scanning	across	a	range	of	masses	to	observe	their	partial	
pressure.	Both	height	and	shape	of	peaks	can	be	viewed.

1. On	the	Mode menu,	click	Analog or	select	the		 		icon	from	the	toolbar.

2.	 Specific	values	for	different	mass	units	can	be	viewed.

•	 Move	the	cursor	to	the	main	display	area	and	hold	down	the	left	mouse	
button.

•	 The	title	bar	will	change	to	allow	you	to	view	the	specific	partial	pressure	
and	possible	gas	identification	for	the	selected	mass.

•	 You	can	move	the	cursor	to	show	partial	pressure	for	different	masses.

The gas identification list is stored in a text file called “mass.txt.” It 
can be customized for your application.

Bar Mode Overview

Bar mode	allows	scanning	across	a	range	of	masses	to	observe	their	partial	pres-



3-4   |   System 2000 Software

sures.

1.	 From	the	Mode menu,	click	Bar or	select	the		 		icon	from	the	toolbar.

2.	 Specific	values	for	different	mass	units	can	be	viewed.

•	 Move	the	cursor	to	the	main	display	screen	area	and	hold	down	the	left	
mouse	button.

•	 The	title	bar	will	change	to	allow	you	to	view	the	specific	partial	pressure	
and	possible	gas	identification	for	the	selected	mass.

•	 You	can	move	the	cursor	to	show	partial	pressure	for	different	masses.

The gas identification list is stored in a text file called “mass.txt.” It 
can be customized for your application.

Placing Labels

A	label	can	be	placed	on	the	screen	only	from	an	Analog or Bar mode	window.

1.	 Right-click	anywhere	from	within	the	Analog or	Bar mode	main	display.
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2.	 Click	Label.	The	Label dialog box	appears.

3.	 Type	the	label	text	into	the	text	box	and	then	click	OK.

4.	 A	pen	icon	appears.	Move	the	pen	icon	to	the	location	where	the	label	is	to	

Figure 3-1.
Label dialog box for 
Analog and Bar modes.

appear	and	click	the	left	mouse	button.

5.	 To	move	the	location	of	the	label	after	it	is	placed,	press	and	hold	down	the	
left	mouse	button	on	the	label	and	move	the	label	to	the	desired	location.	

6.	 To	delete	the	label,	move	the	label	off	the	main	screen.

Meter Mode Overview

Meter mode	allows	use	of	up	to	12	meters.	Each	meter	can	be	independently	set	
to	monitor	one	of	the	following:

•	 Specific	partial	pressure	from	a	quadrupole	head.	For	example,	you	could	set	
up	the	meter	to	look	for	the	partial	pressure	of	Mass	28.

•	 Digital	or	analog	input	module.
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•	 Calculation	or	link	from	another	data	source.

•	 Concentrations	for	a	selected	sample	stream.

•	 In	addition,	you	can	define	unique	scanning,	display,	alarm,	and	analog	out-
put	settings.

1.	 From	the	Mode menu,	click	Meter or	select	the		 		icon	from	the	tool-
bar.

2.	 Each	meter	has	a	bar	representing	a	measured	value.	Text	under	the	meter	
displays	the	numeric	value	of	the	measured	parameter.

3.	 Each	meter	can	be	set	to	display	alarm	limits.	As	long	as	the	measured	value	
is	within	the	high	and	low	alarm	limits,	the	meter	bar	appears	in	green.

4.	 When	an	alarm	condition	occurs,	the	meter	bar	appears	in	yellow	or	red.

5.	 Any	other	actions	associated	with	alarms	are	activated	if	the	limit	is	exceeded	
(e.g.,	running	an	information	file,	setting	off	a	digital	or	analog	output).

6.	 Before	changing	meter	properties,	you	have	to	select	the	meter	by	clicking	on	
it.	The	meter	will	be	highlighted	with	a	yellow	rectangle.

Annunciator Mode Overview

Annunciator	mode	allows	viewing	of	up	to	12	Annunciator	display	windows,	
each	of	which	can	be	set	to	monitor	the	following:

•	 Specific	partial	pressure	from	a	quadrupole	head.	For	example,	you	could	set	
up	the	meter	to	look	for	the	partial	pressure	of	Mass	28.

•	 Digital	or	analog	input	module.

•	 Calculation	or	link	from	another	data	source.

•	 In	addition,	you	can	define	unique	scanning,	display,	alarm,	and	analog	out-



Modes of Operation   |   3-7

put	settings.

1.	 Select	Annunciator	from	the	Mode	menu	or	select	the			 			icon	fromthe	
toolbar.

2.	 Annunciator	is	normally	used	to	define	alarm	limits	so	that	one	can	view	
whether	the	selected	value	is	within	the	alarm	limits	using	visual	indicators.

3.	 For	each	channel,	a	green	light	indicates	the	value	is	within	acceptable	limits.

4.	 A	yellow	light	indicates	an	alarm	warning.

5.	 A	red	light	indicates	an	alarm	condition.

Trend Mode Overview

Trend mode	allows	monitoring	of	up	to	eight	different	channels	versus	time.	A	
channel	can	correspond	to	any	of	the	following:

•	 Specific	partial	pressure	from	a	quadrupole	head.	For	example,	you	could	set	
up	the	meter	to	look	for	the	partial	pressure	of	Mass	28.

•	 Digital	or	analog	input	module.

•	 Calculation	or	link	from	another	data	source.

•	 Concentrations	for	a	selected	sample	stream.

•	 In	addition,	you	can	define	unique	scanning,	display,	alarm,	and	analog	out-
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put	settings.

1.	 On	the	Mode menu,	click	Trend or	select	the		 			icon	from	the	toolbar.

2.	 The	main	Trend mode	display	shows	each	channel	as	a	colored	line.	The	Y	
axis	shows	partial	pressure	or	measured	value;	the	X	axis	shows	time.

3.	 You	can	view	the	exact	value	of	a	trend	line	by	holding	down	the	left	mouse	
button	in	the	trend	area.	Display	the	Data File Toolbar	to	see	the	time	of	
each	data	point.

Tabular Mode Feature

Tabular mode	allows	use	of	up	to	eight	channels	per	display	to	view	the	follow-
ing	information	in	table-type	format:

•	 Name	of	channel

•	 Value	for	selected	channel

•	 Alarm	status

•	 Specific	partial	pressure	from	a	quadrupole	head

•	 Concentrations	for	a	selected	sample	stream.
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1.	 On	the	Mode menu,	click	Tabular  or	select	the		 		icon	from	the	toolbar.

2.	 If	an	alarm	was	defined	and	the	alarm	has	been	exceeded,	an	alarm	indicator	
will	appear	to	the	right	of	the	main	table.

Leak Check Mode Overview

Leak Check	mode	checks	the	vacuum	system	for	leaks.

	 By	applying	a	tracer	gas	of	known	mass	to	the	outside	walls	of	the	vacuum	
system,	you	can	monitor	the	internal	vacuum	system	partial	pressure	of	the	
tracer	gas.	An	increase	in	partial	pressure	indicates	a	leak.	You	can	further	
isolate	the	leak	by	observing	the	increase	in	the	measured	tracer	gas	in	re-
sponse	to	different	injection	points.

1.	 On	the	Mode menu,	click	Leak Check	or	click	the			 			icon	on	the	tool-
bar.
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2.	 Leak Check	display	shows	the	level	of	the	selected	mass	on	the	Y	axis	and	
time	on	the	X	axis.

3.	 Up	and	down	arrows	(on	the	right	of	the	leak	check	display)	indicate	whether	
the	current	measured	value	of	the	selected	tracer	gas	is	increasing	or	decreas-
ing.

4.	 Current	value	of	the	gas	is	also	shown	in	text	format	between	the	arrow	indi-
cators	(e.g.,	10E-11).

5.	 Recommended	sample	dwell	time	is	120	milliseconds	(ms).

6.	 If	you	have	a	sound	card	and	speakers,	you	can	enable	a	leak	tone	in	the	Dis-
play Properties	dialog	box.

Custom Modes

Custom modes	allow	the	mixing	and	matching	of	the	best	features	of	various	
modes	to	create	a	unique	mode	setup.	Three	default	custom	mode	setups	are	
included	with	the	Dycor	software	and	more	can	be	added	as	needed.

For	each	display	added	in	Custom mode,	the	scanning,	display,	alarm	and	analog	
output	options	are	set	as	if	in	that	mode.	For	example,	if	adding	an	Analog mode	
display	within	the	Custom Mode,	all	settings	for	that	display	are	defined	as	if	in	
Analog mode.

Creating a Custom Mode
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1.	 On	the	File menu,	click	New or	select	the			 			icon	on	the	toolbar.

2.	 On	the	Edit menu,	click	Add Display.	Click	the	type	of	display	you	want	to	
add	from	the	list	of	standard	mode	types.

3.	 Under	Data Source,	click	on	Device and	click	on	the	device	you	want	to	en-
able.	

4.	 On	the	File menu,	click	Save As	to	save	the	Custom mode.	Or	select	

	 one	of				 			icons	in	the	toolbar	to	save	the	Custom mode	to	
one	of	the	predefined	Custom	mode	file	names	(Dycor1.dyc,	Dycor2.dyc,	
Dycor3.dyc).	Custom mode	files	are	given	a	.dyc	file	extension.

5.	 To	retrieve	the	custom	mode	file	at	a	later	time,	on	the	File menu,	click	Open 
Configuration.	If	you	used	one	of	the	predefined	icons,	just	click	on	one	of	
the			

	
				icons	to	retrieve	the	file.

Adding a display in custom mode

1.	 On	the	Edit menu,	click	Add Display.	Click	the	type	of	display	to	add.

2.	 Under	Data Source,	click	Device and	click	on	the	device	to	enable.

3.	 The	system	adds	the	new	display	to	the	Custom mode	display.

Moving or resizing a window in custom mode

1.	 Select	the	display	to	move	or	resize	by	clicking	on	it.

2.	 The	display	is	highlighted	in	yellow.

3.	 Move	the	display	by	pressing	and	holding	down	the	mouse	button	(just	an	
outline	of	the	display	is	visible)	while	moving	the	mouse.	Release	the	mouse	
button	when	the	display	is	where	you	want	it.

4.	 Resize	the	display	using	standard	Windows	95/98	methods.

Deleting a display in custom mode
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1.	 Click	on	the	display	you	want	to	delete.

2.	 The	display	is	highlighted	in	yellow.

3.	 On	the	Edit menu,	click	Delete Display,	or	press	the	Del button	or	select	the	
			icon	from	the	Custom Mode	toolbar.

4.	 The	display	is	deleted.

Saving custom mode files

1.	 On	the	File menu,	click	Save As.	You	can	save	the	Custom	mode	setup	under	
a	new	name	or	use	one	of	the	predefined	icons.

2.	 By	default,	the	system	places	these	files	in	the	folder	where	the	Dycor	2000	
Software	is	installed	and	gives	the	file	a	.dyc	extension.

3.	 Click	Save to	save	the	file.

If you save a custom mode file in the install folder with the name 
“startup.dyc” it will automatically be opened when the program 
starts.

Opening custom mode files

1.	 On	the	File menu,	click	Open Configuration	or	select	the			 								icon	
from	the	Custom Mode	toolbar.

2.	 Navigate	to	the	location	of	the	Custom	mode	file	to	open.

3.	 Click	the	Custom	mode	file.

4.	 Click	Open.

Adding	custom	mode	files	to	the	mode	menu

1.	 On	the	Mode menu,	click	Set Menu.
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2.	 Set Custom Menu	dialog	box	appears.	You	can	associate	a	Custom	mode	
file	to	appear	at	the	bottom	of	the	mode	menu.	

3.	 You	can	also	provide	a	menu/button	name	to	appear	instead	of	the	filname	at	
the	bottom	of	the	menu.

4.	 Browse Button	-	navigates	to	the	location	of	the	Custom	mode	file.

5.	 Menu/Button Name	-	this	is	the	name	that	appears	at	the	bottom	of	the	
mode	menu.

These	files	are	recalled	when	pressing	the	
	 	

icons.

Figure 3-2.
Set Custom Mode 
menu dialog box.
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PREFERENCES

The Automatic Filament Enable feature allows you to automatically turn on the 
filament for all active quadrupole heads.

Select Edit/Preferences

On the Edit menu, click Preferences.

• Automatic Filament Enable Check Box

 When checked: turns the filament on for all connected quadrupole heads 
automatically when scan is started.

• Pressure Units
 Select the pressure units to use for all quadrupole devices.

• DDE Item Separator
 Select the character that will separate multiple data items in a Dynamic Data 

Exchange (DDE) message.

• Trend Colors
 Set the default trend channel colors.

• Data File Size
 Set the maximum size for a data file. This can be an integer between 1 and 

16. The normal value is 1 megabyte. Setting the data file size to a higher 
value will increase the size of your data files as well as the size of the trend 
graph buffer. As a result of this increase, it will require more disk space and 
memory.

Figure 4-1.
Preferences dialog box,  
Automatic filament 
enable check box.
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SCANNING DATA

This chapter contains information on how to scan data, including how to perform 
calculations or link data from a different display.

Defining Scan Settings

Scan settings allow you to define the type of information you want to gather from 
the selected device. For Trend and Tabular modes you must first select a chan-
nel before you can define scan settings.

Right-click on the applicable display and then click Scan.

Figure 5-1.
Properties dialog box- 
Scan tab..

• Data Source 

 You can select the device from which to scan, or temporarily disable the 
scanning device.

Disabled
 All other options from Scan tab are disabled. Use this option to disable the 

display.

Device
 Use this list box to select the device from which to scan.
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To add the device if it is not listed, on the Edit menu, click Add De-
vice. 

Function 
 Determines the function of the device. Options are Ion Current, Total 

Pressure, Analog and Digital Input functions, and Concentration.

Total Pressure
 Options for specific mass unit or dwell time are disabled. Only total pres-

sure is displayed.

Link From
 Data can be linked from one display to another. This can save scanning 

time since the system only needs to scan the data one time.

1. Select the display to receive the linked data from another data source.

2. Right-click from the display and click Scan.

3. From the Data Source section, click Link From.

4. Select the data source to link from using the list box to the right of Link 
From.

You cannot link data into an Analog or Bar mode window.

Calculation 
Display the results of a calculation.

• Scan MassRange (for Analog or Bar mode)

 Set low and high mass numbers to define the range to scan..

• Mass (all modes other than Analog and Bar)

 Define the specific mass number to track. You can also select a gas from the 
list to the right of the mass number.

The gas list is stored in a text file called “gas.txt.” It can be custom-
ized to your application.
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• Samples per AMU (Analog Mode only)

 Number of samples the system will take for each selected AMU. The higher 
the samples-per-AMU, the better the resolution. In Analog mode, more 
samples per AMU allow you to resolve separate peaks more easily. You can 
set this value between 4 and 15.

• Dwell Time

 Time the system allots for each sample. Dwell time determines scanning 
speed and background noise. The more time allotted for each sample, the 
higher the signal-to-noise ratio. Very low pressures require a slower scan 
speed. 

• Auto Zero  (Quadlink only)

 Checked - Allows subtraction of the amplifier drift effects from all readings.

There will be a speed penalty if Autozero is turned on because the system takes 
two readings for each reading displayed.
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Turning the Filament On/Off

1. On the Control menu, click Fiament or click the   icon on the toolbar.

If you have more than one head:

2. Filament Control dialog box appears. All active quadrupole heads are dis-
played with a light bulb appearing to the left of the quadrupole head names.

3. Click a quadrupole head name to toggle the filament on/off state. When the 
filament is turned on, the light bulb is yellow.

4. To turn the filament on for all quadrupole heads, click All On. To turn off the 
filament for all quadrupole heads, click All Off.

To turn all heads on or off, hold the Shift Key down and click on the     
   icon in the toolbar.

Turning the Multiplier On/Off

1. On the Control menu, click Multplier or select the  
 
icon from the tool-
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bar.

If you have more than one head:

2. Multiplier Control dialog box appears. All active quadrupole heads are 
displayed with a lightning bolt appearing to the left of the quadrupole head 
names.

3. Click a quadrupole head name to toggle the multiplier on/off state. When the 
multiplier is turned on, the lightning bolt is red.

4. To turn the multiplier on for all quadrupole heads, click All On. To turn off 
the multiplier for all quadrupole heads, click All Off.

To turn all multipliers on or off, hold down the shift key and click on 
the      icon on the toolbar.

Scanning
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Starting a Scan

1. Select the   icon from the toolbar or on the Control menu, click Scan.

2. Scanning will appear in the status bar at the bottom of the screen.

3. If you have scheduled scans at timed intervals and the system has finished the 
previous scan and is waiting to start the next scan, the time remaining before 
the next scan begins is displayed.

4. Idle is displayed when the system is not scanning.

Stoping a Scan

Select the     icon from the toolbar or on the Control menu, click Scan to 
toggle the scan off.

Scheduling Scans

1. On the Control menu, click Schedule or click the     icon in the toolbar.

2. The Schedule dialog box appears

• Single Scan
 Tells the system to run a single scan when the  icon is selected. The 

system will stop scanning after one scan.

Figure 5-2.
Schedule dialog box.
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• Continuous
 Tells the system to run scans at timed intervals once the  icon is selected.

• Scan Interval Text Box
 Type a number to specify the time delay between scans. The units this num-

ber represents depend on whether the scans were scheduled using minutes 
or seconds as the time interval.

 Minutes
 Use minutes as the interval between successive scans. Uses the 

number specified in the Scan Interval text box to determine the 
scheduling.

 Seconds 
 Use seconds as the interval between successive scans. Uses the 

number specified in the Scan Interval text box to determine the 
scheduling.
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CALCULATIONS

Calculations can be performed for Meter, Annunciator, Tabular and Trend 
modes. You must select the display module that will be the basis for the calcula-
tion (Data cell) by right-clicking in that module for Meter, Annunciator and 
Tabular modes. For Trend mode, click anywhere on the display and then select 
the channel for the Data cell on the Calculation tab. Data from multiple displays 
can be used to create a calculation.

Perform a Calculation

1. Right-click on the desired module and click Calculation. The data from 
this module is represented by the Data cell in the Calculation Editor. 
On the Trend display, right-click anywhere and then select the channel 
on the Calculation tab.

2. Click Edit.

3. The Calculation Editor dialog box opens.

4. The Data cell in the Calculation Editor contains the data from the 
module or channel you selected for that mode. If you want to add another 
data source, click the Data Source to be inserted from the Data Source 
list box which contains the other modules/channels on the display. Click 
Insert.

Figure 6-1.
Calculation Editor.
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5. Insert an arithmetic operator by selecting your choice in the Operators 
box. Click Insert.

6. To insert a Constant, enter it in the Constant text box and click Insert.

7. Connect the cells in the Calculation Editor by left-clicking the source 
cell and right-clicking the destination cell. Operators that require two 
inputs will have two arrows pointing towards the cell.

8. To test the calculation in real time, click the Operator and then click the 
Calculate button. 

9. To delete a cell, click on it and click Delete Cell. The cell and all links 
into and out of the cell are deleted.

10. To delete all links into and out of a cell, select the cell and click Delete 
Links.

11. Click OK to accept the calculation.

To select multiple cells, hold down the shift key while clicking with 
the left mouse button.

Arithmetic Operators
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Following are the valid arithmetic operators and the functions associated with 
them.

Plus Adds two inputs.

Minus Subtracts the bottom input from the top input.

Multiply Multiplies two inputs.

Divide Divides the top input by the bottom input.

e∧x Provides the natural log of the input, ex.

Ln Inverse of ex.

Log Provides the base 10 log of the input.

10∧x 10 raised to the x power, where x is the input.

x∧y Raises x to the y power, xy, x is the top input and y is the 
bottom.

This operator can be used for roots of x (x0.5, x0.33) and inverse x (x-1)

Abs Takes the absolute value of the input

Average Averages the top input over the past number of points given 
by the bottom input. The bottom input must be a constant 
between the numbers 0 and 10,000.

High Hold Holds the highest value from the past number of points 
given by the bottom input. The bottom input must be a 
constant between the numbers 0 and 10,000. Entering a 0 
or 1 for the bottom input will retain the highest number for 
the entire scan without resetting.

Low Hold Holds the lowest value from the past number of points 
given by the bottom input. The bottom input must be a 
constant between the numbers 0 and 10,000. Entering a 0 
or 1 for the bottom input will retain the lowest number for 
the entire scan without resetting. 

Slope Takes the slope of the top input by computing its last data 
point and a data point x points past, where x represents the 
bottom input. The bottom input must be a constant between 
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the numbers 2 and 10,000.

Averaging example

Data is the top input and 20 is the bottom input to an Average cell. The result 
will be the average of the past 20 data points. If there are only 5 data points, then 
the result will be only the average of the past 5 data points. If there are 21 data 
points, the oldest data point will be discarded. This could be useful in averag-
ing out the noise from a signal or computing the average for a scan during a set 
period of time.

Applying Offset and Gain Values to Readings

Analog and Bar Mode only.
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1. Right-click from a display .

2. Click Calculation.

Figure 6-2.
Properties dialog box- 
Calculation tab.

 Offset
 Adds the offset value to the measured reading. Set value to 0 for no off-

set.

 Gain
 Multiplies the reading by the number entered in the gain text box. Set 

value to 1 for no gain.

 Offset 2
	 Adds	the	entered	value	after	the	first	offset	is	applied	and	the	gain	is	ap-

plied. Set value to 0 for no offset value.

3. Click OK to apply these values to the readings.
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SETTING UP THE DISPLAY

Display Screen

To set the display for a mode, right-click the mouse button on a display and then 
click Display. The Display tab is highlighted. For modes using channels, Trend 
and Tabular Modes, you must first select a channel before you can define the 
scan settings.

Figure 7-2.
Trend Properties 
dialog box - Display 
tab. 

Figure 7-1.
Analog Properties 
dialog box - Display 
tab. 
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Title

Type the Title for the display. It will then appear in the title bar for the window 
and in other areas of the software to identify the display window.

Enable Total Pressure

Check Box. Applies only for Analog/Bar modes. When checked - total pressure 
for the quadrupole head is displayed in the top right of the title bar.

Display Mass Range

Applies only for Analog/Bar modes. Determine which mass range to display. 

The instrument continues to scan over the range selected under the 
scan properties but will only display the selected range in the display 
properties. This enables the user to zoom in on a selected range 
while the instrument continues to collect data over the entire scan 
range.

• Low mass

 Tells the system the first mass unit to display on the far left of the X axis. 
If the mass scanning range is changed, the low mass display setting will 
automatically change to match the new mass scanning range. If you want the 
display to show a different range than the scanning range, you can return to 
this Display option and change the range of AMUs to display on the screen 
without affecting the scanning range.

• High mass

 Tells the system the last mass to display on the X axis. If the mass scanning 
range is changed, the high mass display setting will automatically change to 
match the new mass scanning range. If you want the display to show a dif-
ferent range than the scanning range, you can return to this Display option 
and change the range of AMUs to display on the screen without affecting the 
scanning range.

Autoscale
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When checked the system automatically sets the Y axis based on the highest 
value from the previous scan across the mass range. If you turn on the Autoscale 
feature, the system overrides the Y axis. As the highest peak increases or decreas-
es, the display scale is changed to accommodate the changing highest peak.

Logarithmic

When checked the software uses a logarithmic scale for the display. If not 
checked it uses a linear scale to display readings.

Upper Limit

This value is used only when the Autoscale check box is not checked. You enter 
the upper limit to show on the Y axis.

Lower Limit

This value is used only when the Autoscale check box is not checked. If the 
Logarithmic box is checked, use this list box to select the number of logarithmic 
decades to display on the Y axis using the upper limit as the top of the display 
range. If Logarithmic is not checked, enter a value into this text box for the 
lower limit.

Units

Click for the type of units on which you want the scanned information displayed.

• Custom
 Type a custom unit name

• Precision
 Applies to all except Analog/Bar modes. Defines how precise the reading 

should display by specifying how many decimal places to use. For example, 
if the precision is set to 2, a reading might be 5.22.

Mode

Applies only to Analog/Bar modes. Enables subtract or compare modes. 
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• Normal
 Normal operations. Does not include any data files with the current data.

• Subtract
 Subtracts the saved data from the current data.

• Compare
 Shows the saved data file side-by-side with the current data.

Channel Name

Applies for Trend and Tabular modes. Names the displayed channel.

Channel Color

Applies for Trend Mode. Defines a different color for the displayed channel.

Minutes

Applies for Trend, Leak modes. Defines the time interval to show on the display.

Display Values

If checked, displays channel values in Trend Mode.

Enable Leak Tone * 

If checked, an audio tone will track the measured ion current.

Hide**

If checked, the data channel will not be displayed but will keep tracking the data. 
This is useful when viewing a scan that overlaps another scan.

* Leak Mode only
  **Trend Mode only
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SETTING ALARMS

Accessing the Set Alarms Screen

Setting alarms includes defining alarm limits and defining the actions that should 
be taken when an alarm limit is reached. Alarm limits also appear on the main 
display for the current mode. High and low limit alarms appear in red, high and 
low warning alarms appear in yellow.

Figure 8-1.
Set Alarms dialog box.

To set alarms, right-click the mouse button from the display and then 
click Alarms.
 
For Trend and Tabular modes, first select the channel as the source 
of the alarms before you define the alarm values.
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Enable All Alarms

When checked - enables all high and low alarms. Deactivated when box is not 
checked. Alarms can be deactivated when, for example, your system is not oper-
ating.

High Limit

When checked - enables the high limit alarm.

Name
 Provide a name for the alarm. Used to identify the alarm to the system.

Value
 Type in the high limit value for the alarm. For Analog mode, any mass 

values that exceed the alarm limit are counted even if they are from the same 
scan.

Count
 Defines the number of consecutive readings that must be above high alarm 

limit before the alarm is triggered. Higher count values decrease the possibil-
ity that a transient or noise signal will set off a false alarm.

High Warning

When checked - enables high warning alarm system.

Name
 Provide a name for the alarm. Used to identify the alarm to the system.

Value
 Type in the high limit value for the alarm. Must be lower than the high alarm 

value. For Analog mode, any mass values that exceed the alarm limit are 
counted even if they are from the same scan.

Count
 Defines the number of consecutive readings that must be above this limit be-

fore the alarm is triggered. Higher count values decrease the possibility that a 
transient or noise signal will set off a false alarm.

Low Limit
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When checked - enables the low limit alarm. 

Name
 Provide a name for the alarm. Used to identify the alarm to the system.

Value
 Type in the low limit value for the alarm. For Analog mode, any mass values 

that fall below this limit are counted even if they are from the same scan.

Count
 Defines the number of consecutive readings that must be below this limit be-

fore the alarm is triggered. Higher count values decrease the possibility that a 
transient or noise signal will set off a false alarm. 

Low Warning

When checked - enables the low warning alarm.

Name
 Provide a name for the alarm. Used to identify the alarm to the system.

Value
 Type in the low limit value for the alarm. Must be higher than the low alarm 

value. For Analog mode, any mass values that fall below this limit are 
counted even if they are from the same scan.

Count
 Defines the number of consecutive readings that must be below this limit be-

fore the alarm is triggered. Higher count values decrease the possibility that a 
transient or noise signal will set off a false alarm. 

AutoSet Button

When selected, this button automatically sets the alarm levels as follows:

 High Limit 10 times the current scan value
 High Warning 5 times the current scan value
 Low Warning 5 times less than the current scan value
 Low Limit  10 times less than the current scan value

Action Button

For all four alarms. The Action button is used to specify what action the system 
should take when the specified alarm is triggered.



8-4   |   System 2000 Software

Dialog Box 
 Message This message displays in the Alarm dialog box when the alarm 

is triggered.

 Info File Select a file by typing in the name or Browse to navigate to the 

Figure 8-2.
Alarm Action dialog 
box.

location and select it. This is the file that will launch when you 
click Information in the Alarm dialog box. 

 ]The file could, for example, provide help to the operator on what action to 
take when the alarm is triggered. 

Sound 
 Use the Browse button and navigate to the location of the sound file and 

select the file. This allows you to provide a sound file with instructions or a 
warning sound to the operator when the alarm is triggered.

Script  (System 2000-Multi Only)
 Select a script that will perform some automated system instructions when 

the alarm is triggered. You create the scripts in the System 2000 software to 
perform predetermined actions, for example, turning the filament off or run-
ning a set of steps. 

Script Normal (System 2000 Multi-Only)
 Select a script that will perform some automated system instructions when 

the alarm returns from a triggered state.

Digital Output
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 Define how to send the alarm information to a digital output. Select the 
device to which you want to send the digital output by using the Device list 
box. Select the digital output module using the Module list box.

Test Dialog Button
 Click to test the alarm.
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SETTING ANALOG OUTPUTS

Process readings can be directed to devices capable of receiving analog output 
signals including Optomux devices and quadrupole heads.

Setting analog outputs does not apply to Analog, Bar or Leak 
modes.

How to Set the Analog Output

•	 Right-click	from	a	display	and	then	click	Analog.

 For Trend and Tabular modes,	first	select	the	channel	as	the	source	of	the	
analog input.

Figure 9-1.
Properties dialog box- 
Analog tab.

 Device
 Indicates to which output device to send the analog output signal. For Optomux 

devices	 the	 system	 sends	 the	 reading	 to	 the	module	 specified	 for	 the	Optomux	
module for that device.
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 Module
	 Indicates	the	Optomux	module	to	which	the	system	will	direct	the	analog	input.

 Full Scale
	 User-defined	value	as	the	top	of	the	analog	output	range.

 Zero
	 User-defined	value	as	the	bottom	of	the	analog	output	range.



Master Alarms   |   10-1

MASTER ALARMS

Master Alarms allows you to combine standard alarms in a flow chart graphical 
editor using Boolean logic. Multiple master alarms can exist with each master 
alarm independently triggered. Once a master alarm is triggered, you can deter-
mine which actions should be taken including: playing a sound file, displaying a 
message, running a script or setting a digital output. Once a master alarm returns 
to normal it can run a script.

Standard alarms must be created before a master alarm can be cre-
ated to connect them with Boolean logic.

Setting the Alarm

1. On the Edit menu, click Master Alarms.

2. Click New to create a new master alarm or click an existing alarm and then 
click Edit. Click Delete after highlighting a master alarm to delete it.

3. You will be prompted with the Master Alarm Editor dialog box. It is here 
that you define the master alarm by combining standard alarms with Boolean 
operators.

Master Alarm Editor

Figure 10-1.
Master Alarm Editor.
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1. Click on the standard alarm from the Alarms List box to insert it in the edi-
tor workspace and then click on the Insert button below the list of standard 
alarms. The standard alarm is placed in the main workspace. To move the 
alarm within the workspace press and hold the left mouse button on the cell 
and drag it to its new location.

2. To insert a Boolean operator, click on the Boolean operator from the Opera-
tors list box and click on the  Insert button just below the list of Boolean 
operators.

3. Connect the standard alarms to the Boolean operator. All Boolean operators 
require two inputs, except for NOT, which requires only one. (You can also 
do nested Boolean logic.) 

4. To connect the cells, left-click on the standard alarm and then right-click on 
the Boolean operator. The two cells are connected with a line with an arrow 
leading to the Boolean operator. Repeat this step for the other standard alarm 
you want to connect to the Boolean operator.

5. Connect the Boolean operator to the equal sign (=) cell.

6. Type in a name for the master alarm using the Name text box.

7. Click the Action button and determine what action to take once the master 
alarm is triggered.

 Calculate 
 Determines whether the master alarm is currently true or false. Select any 

cell to see the current state of that alarm.

Action 
 Determines what action to take if the master alarm returns true and is trig-

gered. This works the same as for standard alarms.

Delete Cell 
 Deletes the selected cell. All related links are removed.

Delete Links 
 Deletes all links into or out of the selected cell. Select the cell then click 

the Delete Links button.

Alarm Enable 
 When checked - activates the master alarm. Not checked - master alarm is 
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temporarily disabled.

Name
 Provides a name for the master alarm that will be used to identify it.

Boolean Operators

 And
 If A and B are both true, returns true. Otherwise, returns false.

 Or
 If A or B is true, returns true. Otherwise, returns false.

 Not
 Reverses true/false argument of input. Requires only one input. 
 If input is true, returns false.

 Nand
 If A and B are both true, returns false. Opposite of AND.

 Nor
 If A or B is true, returns false. Opposite of OR.

 Xor 
 If either A or B is true, but both are not true, returns true. 
 Otherwise returns false.
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DEGASSING A QUADRUPOLE HEAD

Degassing a quadrupole head involves increasing the filament current to burn off 
any contaminants that may have collected on the filament.

How to Degas a Quadrupole Head

1. On the Control menu, click Degas.

2. Click on the quadrupole head(s) you want to degas. The light bulb will turn 
yellow.

3. Click All On to select all the quadrupole heads or click All Off to deselect all 
the quadrupole heads.

4. Type in the number of minutes for the system to degas in the Minutes text 
box. The maximum is 10 minutes.

5. To start the degassing process, click Start. A dialog box message appears 
indicating that the system is degassing.

6. To cancel the degas operation, click Cancel.

While in the degas operation, the filament cannot be turned off on 
those quadrupole heads being degassed.

Figure 11-1.
Control/Degas dialog 
box.
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AUTO TUNE 

The Auto Tune function adjusts and optimizes RF frequency, mass resolution, 
and mass position. You can also check to see if the current tune parameters are 
within tolerance. Ideally, you should use a calibration gas with peaks at the low 
and high ends of the mass range. However, the mass spectrometer can be cali-
brated using residual air. 

Auto Tune Dialog Box

On the Control menu, click  Auto Tune to bring up the Auto Tune dialog box. 

Device List Box

 Allows you to select the quadrupole head on which to perform the Auto 
Tune.

Figure 12-1.
Automatic Calibration 
dialog box.
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Properties 

 Takes you to the Device Properties dialog box where you can view or 
change properties for the device selected from the Device list box.

 Mass Text Box

	 Defines	the	low	and	high	mass	of	the	calibration	gases.	The	left	text	box	
corresponds to the low mass. Ideally a calibration gas as close as possible to 
1 should be used. For the high mass, use a calibration gas that is close to the 
top of the operating range. For example, if operating up to 100 AMU, use a 
calibration gas in the 90s AMU range.

Width Text Box

 Allows you to set the resolution by specifying the width in AMU that each 
peak should have for both the low and high mass calibration gas. Width is 
measured at 25% of the total peak height. If, for example, you set the peak 
width at .8, you are telling the system that at 25% peak height it should be 
.8 AMU wide. Decreasing the width improves the resolution but lowers the 
sensitivity. To get better sensitivity, increase the width. If the peak width is 
set too wide, you may start to lose the ability to distinguish between adjacent 
peaks.

RF Tune Box

 Displays the RF Tune value in the box to the right of the label. The square to 
the	left	appears	green	if	the	value	is	within	specifications.	It	appears	red	if	out	
of	specification.

Resolution Box

	 The	square	to	the	left	appears	green	if	the	value	is	within	specifications	and	
red	if	out	of	specification.	For	example,	if	the	width	is	set	to	.8,	the	indicator	
will	appear	green	if	the	AMU	width	is	sufficiently	close	to	.8	AMU	at	25%	
peak height.
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Position Box

 Tells you whether selected masses (from high and low calibration gases) are 
properly positioned. In other words, you want to ensure that the peak for 18 
appears at 18 and not at 18.5 or 17.5. It allows you to shift the peaks left or 
right.	The	square	to	the	left	appears	green	if	the	value	is	within	specification	
or	red	if	out	of	specification.

Check  

 Checks the RF Tune, Resolution and Position but does not attempt to 
change them. The settings appear on the display window above the Position 
and Width text boxes. 

Start  

 Starts the Auto Tune, optimizing RF Tune, Resolution and Position. When 
complete, the display shows data that is properly positioned, resolved and 
with proper sensitivity.

Stop 

 Stops the Auto Tune or Auto Tune Check process.

Cancel 

 Cancels the Auto Tune and discards all Auto Tune changes.

OK 

 Saves all Auto Tune changes and exits the dialog box.

Status 

	 Indicates	whether	or	not	the	system	is	scanning,	the	filament	is	warming	up	
or	the	system	is	finished	doing	the	Auto	Tune	or	Auto	Tune	Check.

Performing an Automatic Tune
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Figure 12-3.
RF Tune turns green 
and value appears in 
RF Tune box.

To perform  an Auto Tune, on the Control menu, click Auto Tune. The Auto 
Tune dialog box appears.

•	 Under	Device, click on the device you are using.

Figure 12-2.
Automatic Tune dialog 
box.

•	 Adjust	the	Mass and Width values or use the defaults. 

•	 Click	Start.

•	 RF Tune
 Turns Yellow.
 Turns Green.
 RF Tune Value appears in the box next to it.

•	 Resolution 
  Turns Yellow
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  Peaks appear in the  Low and High boxes.
  Turns Green.

•	 Position

  Turns Yellow.
  Turns Green.

•	 Click		OK  after Auto Tune to save all changes made while in this  dialog 
box. 

Figure 12-4.
Resolution turns 
green and peaks 
appear.

Figure 12-5.
Position turns green 
and auto tune is 
complete.
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Resolving an RF Tune Error

Analyzer electronics must be RF-tuned to match the quadrupole analyzer head. 
New analyzers are tuned at the factory. If you see the message  “RF Tune Fail-
ure” in the Devices & Log status box, it may be caused by one of the following.

•	 The	electronics	were	removed	from	one	head	and	installed	on	another.
•	 Circuit	boards	were	replaced	during	a	repair.
•	 There	is	an	electronics	circuit	failure.
•	 The	analyzer	head	is	damaged.

Setting the RF Tune

The RF Tune is set using the Auto Tune dialog box in the System 2000 software.

1. On the Control menu, click Auto Tune.

If you have more than one device, make sure you have selected the 
correct device to initialize.

2. On the Auto Tune dialog box, click the Start button. When the RF Tune box 
turns green, click the Stop button.

If the RF Tune box turns red, there is a circuit failure, or the analyzer 
head is damaged. Please contact AMETEK for assistance.

3. Click OK to close the Auto Tune dialog box.

4. On the Mode menu, click Analog. Right-click on the screen and click on 
Display. In the Display mass range boxes, enter “1” for Low and “50 for 
High. Allow the analyzer to warm up for approximately an hour.

5. At the end of an hour, observe the positions of the peaks on the analog screen 
to determine how much coarse tuning is needed before you can perform an 
auto tune. For example, if you are sampling air, look at peaks at mass/charge 
14 and 40.

Click on the left mouse button and hold it down to move the cursor 
anywhere on the mass scale to see the location on the mass scale.

 If the peaks of interest are off by more than 0.5 AMU, you must manually 
adjust the mass position. For example, if the maximum of peak 14 appears 
at 13.6 and peak 40 appears at 39.8, no adjustment is necessary. However, if 
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peak 14 reads 13.1 and peak 40 reads 39.03, you need to perform a manual 
adjustment.

Manual Adjustment of Mass Position

If the peaks are off by more than 0.5 AMU, you need to perform a manual adjust-
ment	so	that	the	peaks	can	be	brought	into	range	close	enough	to	perform	a	fine	
adjustment using the Auto Tune feature.  

On the Edit menu, click Device Properties and then click the Tune Parameters 
tab.

1. While looking at the scan, note the positions of the peaks to determine in 
which direction you need to adjust the mass position.

 If the peaks shift to the right (higher)
	 Decrease	the	numbers	in	the	tune	file	at	“low	position”	and/or	“high	posi-

tion.”

 If the peaks shift to the left (lower)
	 Increase	the	numbers	in	the	tune	file	at	“low	position”	and/or	“high	position.”

 Start out by changing the numbers by approximately 1 unit (e.g., from 3.20 
to 2.20, or from -1.50 to -2.50). After you change the numbers, click OK and 
observe the next analog spectrum to see how the peaks have shifted. If the 
resulting peak positions are acceptable, go to Step 2. If the peak positions are 
still off by more than 0.5 AMU, repeat Step 1.

 Once you have brought the peak positions into a range closer than 0.5 AMU, 
you can perform an Auto Tune.

2. On the Control menu, click Auto Tune. 

 Click the Start button and observe the boxes for RF Tune, Resolution and 
Position. When all three status lights have turned green, click OK.

Your analyzer should now be properly calibrated.
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WORKING WITH DATA FILES

Saving Data Files

Displayed information can be saved for later viewing or printing. Each data 
record within a data file contains scan data from the display(s). Data records are 
created in serial format as the data becomes available from the system. For a 
Custom mode, for example, each display will be saved as a data record.

1. Select the display or displays for which data will be saved. 

• Hold down the shift key to select multiple displays. 

• Selecting a highlighted display deselects the display.

• If no display is selected, the system saves data for all displays in the mode.

2. On the File menu, click Save Data or the     icon on the toolbar. To acti-
vate this bar, on the View menu, click on Data File Toolbar.

3. You are prompted with the Save As dialog box. You can specify data file at-
tributes.

4. Once the attributes are set, name the data file and place it in a folder using 
standard Windows techniques.

Figure 13-1.
Save As dialog box.
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• Start Saving
 Prompts the system to start saving data with the next scan and to continue 

saving data files.

• Save Now 
 Prompts the system to save the most recent scanned data and then stop 

scanning. If there are multiple Trend modes within a Custom mode setup, 
only one can be selected for which to save data.

• When File Full 
 Chooses how to handle cases where the data file is greater than 1 megabyte.

- Start New File
  Save the data to a new file. The system automatically appends con-

secutively numbered digits at the end of each new file it creates so it 
is easier to follow the order in which the files were created. Each file 
will be one megabyte in size so the data can be copied to disk.

- Stop 
  Stops  scanning when the file is full.

5. To stop saving data, on the File menu, click Stop Saving.
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Opening Data Files

1. On the File menu, click Open Data or select the    icon in the toolbar.

2. Navigate to the location of the data file. Click on the file.

3. Click Open. The data file appears on the screen. From here it can either be 
viewed or printed.

You can open System 1000 data files. The file is converted to the 
System 2000 format and saved. If the new file was named “test.dat” 
it will be saved as “new test.dat.”
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Moving Through Data Records

1. On the  File menu, click Data File Position, or use the data toolbar to move 
back and forth through the data file using the standard recording symbols 
such as rewind or fast forward.

2. To activate the data toolbar, on the View menu, click Data File Toolbar.

FORWARD      
Go forward one record in the data file.

BACKWARD    
Go back one record in the data file.

GO TO END   
Go to the last data record of the data file.

GO TO START   
Go to the first record in the data file.
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Converting Data File

Use this utility to convert Process 2000 data files into ASCII text.

1. On the File menu, click Convert Data File.

2. Click one or more data files.

3. Click Convert. The Convert window opens (Figure 12-2).

 All Points Use every acquired data point in the conversion.

 Scan Per Row Scan per each row of data

 Number of Rows Enter the number of rows to scan in the Number of 
Rows box.

 Time Interval Enter the number of seconds as the time interval for 
conversion. 

4. The file will be converted and saved with a CSV extension.

Figure 13-2.
Convert data window.
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PRINTING DATA

The System 2000 Software will print scanning information in a manner similar 
to how it is displayed on the screen using the display parameters created for that 
mode. You can view a preview of what will be printed by clicking Print Preview 
on the File menu.

In Custom Mode, the system prints the currently selected display. If you do not 
select a display, the system prints information for each display using the required 
number of pages.

1. Select the display to be printed. If a display is not selected, the entire screen 
will be printed. To select multiple displays, hold down the shift key while 
selecting.

2. On the File menu, click Print or click on the    icon.

3. Type a printer header comment. This information appears in the title of the 
printed pages. Click OK.

4. If you clicked Print from the File menu, a standard Windows 95 Print dialog 
box appears. Set the additional print information.

5. Click OK to print the scanning information.
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SCRIPTS

Scripts

Scripts allow you to automate routine steps such as saving scans to file, starting 
scans, turning on the quadrupole filament, and printing scanned data. In general, 
most operations that you can do manually you can automate with scripts.

Script capabilities are available only in System 2000 Multi software. You must 
create a script file before performing these steps.

Editing a Script

Launches the Dycor Script Editor.

Running a Script

Select and run a script.

Scheduling a Script

1. On the Script menu, click Schedule.

2. The Script Dialog Box appears.

Figure 15-1.
Script Schedule dialog 
box.
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ScheduledScripts
 Displays the currently selected script to be run. Click the Browse button to 

find the applicable script file to be scheduled. Note that there are two scripts 
that can be scheduled independent of each other.

Run Every List Box
 Sets the frequency of the scheduled script. The list box can be used to set 

the frequency using seconds, minutes or hours. Use the text box just to the 
left of this list box to enter a number.

Script Run when configuration file loads
 This script will run when configuration or mode is loaded. Click the Browse 

button and navigate to the folder that contains the script to be run.

Adding Script Files to the Script Menu

It is also possible to run a Script file by clicking Set Menu from the Script menu.

From the Set Script Menu dialog box it is possible to associate script files to ap-
pear at the bottom of the Script menu. A Menu/Button Name can also be pro-
grammed to appear instead of the filename at the bottom of the Script menu.

Browse Button
 Use to navigate to the Script file.

Menu/Button Name Box
 This is the name that appears at the bottom of the Script menu.

Figure 15-2.
Script Menu - Set Menu 
dialog box.
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DYNAMIC DATA EXCHANGE (DDE)

You can copy any of the columns from a Tabular display to the clipboard.

Copying Magnitudes

1. On the Mode menu, click Tabular mode.

2. Right-click  on the display and click Copy Magnitudes. This places the 
DDE data into the clipboard.

3. On the Edit menu, click Paste Special (or Paste Link) in another Windows 
95 application to create the DDE link and continuously update the data in 
real time.

Copying Channels

1. On the Mode menu, click Tabular mode.

2. Right-click on the display and click Copy Channels. This places the name of 
the channel onto the clipboard.

3. On the Edit menu, click Paste Special (or Paste Link) in another Windows 
95 application to create the DDE link and continuously update the channel 
names in real time.

If you are importing data into Microsoft Excel, on the Edit menu, 
click Preferences in the Process 2000 Software and click DDE Item 
Separator. From this menu click Return. This places the numbers 
into separate columns. Select Tab to have the number placed in rows.
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Direct DDE Control

The DDE service name is “Sys2000.” The permanent topics available are:

•	 Command
•	 Status
•	 Other	topics	are	created	with	the	name	of	each	Tabular display.

Sending a Command

1. Initiate a DDE conversation using the Command topic. 
2. The following DDE Execute commands are available:
	 [OPEN	filename]
	 Opens	the	System	2000	configuration	file	filename.

	 [FILAMENT(ON)]
	 [FILAMENT(OFF)]
	 [FILAMENT(ON,	“device”)]
	 [FILAMENT(OFF,	“device”)]
	 Sets	the	filament	state.	If	the	device	isn’t	specified,	turns	all	filaments	on	or	off.

	 	[MULTIPLIER(ON)]
	 [MULTIPLIER(OFF)]
	 [MULTIPLIER(ON,	“device”)]
	 [MULTIPLIER(OFF,	“device”)]
	 Sets	the	multiplier	state.	if	the	device	isn’t	specified,	turns	all	multipliers	on	or	

off.

	 [SCAN(ON)]
	 [SCAN(OFF)]
 Enables scanning.

	 [DEGAS(ON,	“device”)]
	 [DEGAS(OFF,	“device”)]
	 Enables	degas	for	a	specified	device.

	 [SCHEDULE(SINGLE)]
	 [SCHEDULE(CONTINUOUS,	interval)]
 Sets to either single or continuous scan mode. If set to continuous, set the interval 

in seconds.

3. The square brackets and quotes are required. Multiple commands can be sent 
in the same DDE Execute command line.
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Requesting Values in the Devices & Log Window

1. Use the Status topic to request the values. The DDE items available are:
 ITEM  RETURNS
 Devices  List of devices
	 Filaments	 	 List	of	ON	or	OFF	state	of	the	filaments
 Multiplier  List of ON or OFF state of the electron multipliers
 Status  List of device statuses
 ScanState  “Idle” or “Scanning”

2. Use the name of the Tabular display as the topic name to request those val-
ues. 

3. The DDE items available for a data window are:

 ITEM  RETURNS
 Channels  List of channels
 Magnitudes List of current readings

Microsoft Excel 7.0 Example
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On the Edit menu, click Preferences in the System 2000 Software to 
set the DDE Item separator to tab when using this type of example to 
create a DDE link with Microsoft Excel.

Sub Main ()

 DDEcmd = Application.DDEInitiate(“Sys2000”, “Command”)  ‘Initiate the DDE conversation.

	 Application.DDEExecute	DDEcmd,	“[open(“”custom1.dyc””)]”	 ‘Open	a	configuration	file.

	 Application.DDEExecute	DDEcmd,	“[filament(on)][scan(on)]”	 ‘Turn	on	filament	and	start	scan.

	 Application.DDETerminate	DDEcmd	 	 ‘Wait	5	seconds	for	file	to	open

     and take some data.

 Application.WaitTimeSerial(Hour(Now()), Minute (Now()), Second(Now()) + 5)

 DDEdata = Application.DDEInitiate(“Sys2000”, “Tabular”)  ‘Initiate the DDE conversation.

 returnList = Application.DDERequest(DDEdata, “Channels”) ‘Get a list of channels.

 For i = LBound(returnList) To UBound(returnList)

        Worksheets(“Sheet1”).Cells(i, 1).Value = returnList(i)

 Next i

returnList = Application.DDERequest(DDEdata, “Magnitudes”)  ‘Get the data

For i = LBound(returnList) To UBound(returnList)

 Worksheets(“Sheet1”).Cells(i, 2).Value = returnList(i)

Next i

Application.DDETerminate DDEdata

End Sub
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SETTING SECURITY LEVELS

Setting Operator Level Privileges

If all users have access to all software functions, there is no need to 
set security levels.

By default, only the Supervisor can save a configuration or de-
vice parameters. At the Supervisor level, there is no security. All 
functions are available. By setting a password, the Supervisor can 
create an Operator level. At the Operator level, privileges and re-
strictions are set by the Supervisor using the Options button. These 
options do not include saving a configuration or device parameters. 
If the password is not set, all users 

have access to all functions.

1. On the Edit menu, click Security Level.
2. Select Supervisor in the Level box.
3. Click Options to select Operator level 

privileges. Once the privileges have been set 
for the operator, click OK.

To Set a Password
1. In the Level box, select Supervisor.
2. In the Password box, type in a password.
3. Click Set Password. Click OK.

To Log On as Supervisor
1. On the Edit menu, click Security Level.
2. Select Supervisor in the Level box.
3. Type in the password and click OK. 

Figure 17-1.
Set Security Levels 
and Operator Options 
dialog boxes.
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ERROR MESSAGES

SYSTEM 2000 ERROR MESSAGES

Here are all the error messages that can appear in the Devices & Log box. There 
are many other self-explanatory informational and warning messages —these are 
only the errors.

“Quad1” is used as an example device. The actual device name will 
be shown in the Source column.

Source Message Comment

Quad1 Protect pressure exceeded QuadLink only. The filament has 
been turned off because the pres-
sure is too high. The filament  pro-
tectpressure is set in the Protection 
tab of the Device Properties dialog 
box.

Quad1 Filament open failure The filament has burned out and 
must be replaced. The device has 
been set to disabled in the Device 
Properties dialog box.

Quad1 Filament half open One half of the two-part filament 
has burned out. The system is still 
usable, but the filament should be 
replaced as soon as possible.

Quad1 RF tune failure The RF electronics frequency and 
the quadrupole analyzer head are 
mismatched. Follow the procedure 
in the Auto Calibration chapter to 
resolve this error.

Quad1 Filament tripped QuadLink only. The filament has 

NOTE
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been turned off because the pres-
sure is too high for safe operation. 
The device has been set to disabled 
in the Device Properties dialog 
box.

Quad1 Filament short failure The filament resistance is too 
low. The filament may be touch-
ing another ionizer element or an 
electronics failure. The device has 
been set to disabled in the Device 
Properties dialog box.

Quad1 Filament trip: over pressure Dymaxion only. The filament has 
been turned off because the pres-
sure is too high for safe operation. 
The device has been set to disabled 
in the Device Properties dialog 
box.

Quad1 Over temperature failure Dymaxion only. The temperature in-
side the electronics box is too high. 
This ambient temperature outside 
the box may be higher than 40 °C. 
The device has been set to disabled 
in the Device Properties dialog 
box.

Quad1 +15V supply failure  

Quad1 -15V supply failure  

Quad1 +80V supply failure

Quad1 +200V supply failure

Quad1 -200V supply failure

Quad1 General failure Dymaxion only. The electronics 
have failed and require service. The 
device has been set to disabled in 
the Device Properties dialog box.

Quad1 No response The device is not responding at all 
to communications. 

Quad1 Receive TIME-OUT error.
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Quad1 Receive OVERRUN error

Quad1 Receive FRAMING error

Quad1 XMT CHECKSUM error

Quad1 CMD error  

Quad1 ACK error

Quad1 Receive CHECKSUM error

Quad1 Transmit error

Quad1 Communications error These errors all indicate that mes-
sages between the device and the 
PC are being corrupted. 

For all communications problems, check the communications settings in the De-
vice Properties dialog box. Errors could also be caused by a bad cable, RS-232 
to RS-485 converter, a powered-off analyzer, or electronics failure.
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DYCOR OBC SOFTWARE FOR SYSTEM 2000

Accessing the Software

•	 On	the	Edit	menu,	select	Device Properties.

•	 When	the	Device Properties	dialog	box	opens,	click	the	OBC Settings	but-
ton.
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OBC Settings Dialog Box

The	OBC Settings	dialog	box	contains	four	parameter	columns.	Each	column	
represents	an	OBC	channel	and	contains	the	settings	for	that	channel.	You	can	set	
up	the	channels	to	track	concentration	calculations	and	PI	control-loop	control.

Enable OBC Mode dialog box
Checked			 The Dymaxion will scan only the masses defined in the 

OBC Settings dialog box. 

• The Dwell time entered for each mass in OBC Settings 
will be the time used regardless of what has been set up 
previously. Other masses defined in the system will not be 
updated. 

• Analog Input/Output values and Digital Output values will 
continue to be updated. 

• All Analog or Bar mode displays will be disabled. 

Unchecked All OBC control is disabled.

OPC tag name: Device.name.OBC Enabled
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Allow OBC to run after program exit

Checked			 OBC Settings will continue to be used by the Dymaxion 
after the program exits. 

For example: When checked and you configure a concentration function and 
start a scan, the concentration value becomes available to the program. If you 
exit the program, scanning will continue and the concentration value will con-
tinue to be calculated. Access it from the Dymaxion using the serial protocol. 

Unchecked	 All OBC settings will be reset when the program exits. 

For example: When checked and you configure a concentration function and 
start a scan, the concentration value becomes available to the program. If you 
exit the program, scanning stops and the concentration settings are lost.

Fast Scan
Checked			 The Dymaxion acquires a single reading for each mass. 

Unchecked The Dymaxion takes five (5) readings across the top of a 
peak and uses the highest one. 

The Fast Scan setting is used for all masses regardless of the Enable OBC 
Mode setting.

Function
OPTIONS:
Disabled All parameters below will be ignored.

Conc. Ref.
This is the one (1) channel that is designated as the refer-
ence channel. Set it to Conc. Ref. when configuring to do 
concentrations.

Conc. Conc. is the reference gas that will always be present in 
the system. One or more channels can be set to Conc.

Pressure When selected, the partial pressure will be taken and op-
tionally controlled. 

OPC tag name: Device.name.OBC Function N

The N is a number from 1 to 4 corresponding to the OBC channel column. The order is 
1 to 4, left to right.

Mass The mass to scan for the OBC channel. 
OPC tag name: Device.name.OBC Mass N

The N is a number from 1 to 4 corresponding to the OBC channel column. The order is 
1 to 4, left to right.

Dwell Dwell time in milliseconds to use for the mass speci-
fied. 

As the dwell gets shorter, the measured data will get noisier.
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Smoothing
Enables smoothing of the concentration or partial pressure 
value. 

This function applies an exponential smoothing algorithm to the concentration value 
to reduce noise. It will also reduce response time to fast changes in concentration. The 
smoothed concentration is then used for PI control, analog output and alarms.

The smoothing weight value can range between 0.01 to 1.0. A weight of 0 or 1.0 will 
disable smoothing. Weights between 0.1 (more smoothing) and 0.9 (less smoothing) 
work best. A weight of 0.2 works well.

Prop. gain Term used for Proportional-Integral control. 

The OPC tag name is Device.name.OBC Prop Gain N. The N is 
a number from 1 to 4 corresponding to the OBC channel column. 
The order is 1 to 4, left to right.

Integral gain Term used for Proportional-Integral control. 

The OPC tag name is Device.name.OBC Integ Gain N. The N is 
a number from 1 to 4 corresponding to the OBC channel column. 
The order is 1 to 4, left to right.

Min control The minimum PI control value sent to the analog output.
This is a percentage of full scale from 0 to 100. For example: to 
prevent a flow controller from turning off completely, you could 
set this to 5. The flow will never be set lower than 5% of full 
scale. 
The OPC tag name is Device.name.OBC Min Control N. The 
N is a number from 1 to 4 corresponding to the OBC channel 
column. The order is 1 to 4, left to right.

Max control The maximum PI control value sent to the analog output. 
This is a percentage of full scale from 0 to 100. 

The OPC tag name is Device.name.OBC Max Control N. The 
N is a number from 1 to 4 corresponding to the OBC channel 
column. The order is 1 to 4, left to right.

Set point The concentration or pressure PI controller set point. 

The OPC tag name is Device.name.OBC SetPt N. The N is a number from 1 to 4 cor-
responding to the OBC channel column. The order is 1 to 4, left to right.

Set Point
Set Button

Clicking the Set button on the Set point row will save the 
current partial pressure readings for each OBC channel 
into the set point value. This is only valid when the OBC 
Function is set to Pressure.

Concentration
This is the concentration of calibration gas when Function 
is set to Conc. Ref. or Conc. The concentration values for 
all OBC channels must add up to 100. 

The OPC tag name is Device.name.OBC Conc N. The N is a number from 1 to 4 cor-
responding to the OBC channel column. The order is 1 to 4, left to right.
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Sensitivity
This is the calibration factor that is calculated by the Dymax-
ion. It is used to scale pressure to percent concentration. 
Valid only when Function is set to Conc. Ref. or Conc. 

The OPC tag name is Device.name.OBC Sens N. The N is a number from 1 to 4 cor-
responding to the OBC channel column. The order is 1 to 4, left to right.

Sensitivity
Set Button

NOTE: The calibration gas must be flowing before clicking 
this button.

Using the concentration values that you set, the Dymaxion 
calculates new sensitivities. The new values are displayed 
in the boxes on the Sensitivity row. Any calibration errors 
are displayed in the status box. Valid only when Function 
is set to Conc. Ref. or Conc. 

Setting OPC tag Device.name.OBC Cal Cmd = 2 will do a sensitivity calibration.

Cal Average When calibrating concentrations, use an average of scans. 
A value of at least 3 is recommended.

Update
Interval

The Dymaxion scans and updates its analog outputs 
continuously. The System 2000 updates at a slower rate 
so that the Dymaxion isn’t slowed down by communica-
tions overhead. This is the System 2000 data update rate 
in seconds.

Apply button Click to send settings to the Dymaxion without closing the 
dialog box.

I/O Settings… 
button

Displays the OBC I/O Settings dialog box.
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OBC I/O Settings Dialog Box

Analog Out 1 and 2 - Manual Option

When this option box is checked, the value in the box is sent to the analog 
output and held at that value. This overrides any control signal. The valid range 
is 0 to 4095. The value isn’t sent to the Dymaxion until you click OK. 

The OBC tag name is Device.name.Analog Enable 1 and Device.name.Analog Input 2. 

Checked			 The OBC tag will be FALSE. 

Unchecked			 The OBC tag will be TRUE. 

The manual value can be set using OBC tags Device.name.Analog Output 1 and De-
vice.name.Analog Output 2.

Mode
Control Control value is calculated by the PI controller and is sent to 

the analog output.
Value Output is proportional to the concentration or pressure.
Mass Selects which channel to output.

The mass must match one of the OBC channel masses in the 
OBC Settings box. 

Zero For concentration or pressure control, set to 0. 
For value output, the analog output is scaled between the 
Zero value and the Full value.

Full For concentration or pressure control, this set to 100. 
For value output, the analog output is scaled between the 
Zero value and the Full value.

Scale The number of A2D counts that are equivalent to the “Full” 
value. Set to 4095.
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Digital Out 1 to 6

Enable, Mass, Limit

You can assign a function to each digital output. The options are Off, High, 
Low, Filament, and System. 

High and Low are limit alarms. 
Set a Mass (must be one of the OBC channels) and Limit. 
Filament is the filament ON or OFF status. 
System is the set if any system failures occur.

Filament interlock (digital in 1) option 

Checked			 When checked, the filament can only be turned on if voltage is 
present at digital input 1.

Remote (digital 2 in)

Options are Off, Conc., Set Pt. 

Conc. The Dymaxion will do a concentration calibration if voltage is 
applied to digital input 2.

Set Pt The Dymaxion will save the current pressure as the set point 
when doing pressure control.
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System 2000 OBC Variables

In the variable names below, name is the actual device name.

Name Type Read/
Write Notes

System.Scan
Device.name.Status
Device.name.Status String
Device.name.Filament Enabled
Device.name.Multiplier Enabled
Device.name.OBC Enabled

Discrete
Integer
String
Discrete
Discrete
Discrete

RW
R
R
RW
RW
RW

Turn scan on/off

Enable OBC scanning

Device.name.Analog Enable 1 Discrete RW 0 = manual, 1 = Automatic
Device.name.Analog Enable 2 Discrete RW 0 = manual, 1 = Automatic
Device.name.Analog Output 1 Integer RW 0 - 4095
Device.name.Analog Output 2 Integer RW 0 - 4095

Device.name.OBC Cal Cmd Integer RW 2 = calibrate
Device.name.OBC Cal Status Integer R 0 = done 

-1 = in progress,
1 = Cal required
10 = Cal failed. Filament off or 
system error.
11 = Cal failed. No concentration 
channels configured.
12 = Cal failed. Ion current too low 
(< 1E-20 after subtracting back-
ground) or concentration percent-
ages all set to zero.
13 = Cal failed. Sensitivity calcula-
tion error.

Device.name.OBC Function 1 Real R OBC Channel function
Device.name.OBC Function 2 Real R 0 = Disabled, 1 = Conc
Device.name.OBC Function 3 Real R 2 = Conc. Ref., 3 = Pressure
Device.name.OBC Function 4 Real R

Device.name.OBC Mass 1 Real OBC Channel mass
Device.name.OBC Mass 2 Real
Device.name.OBC Mass 3 Real
Device.name.OBC Mass 4 Real

Device.name.OBC Conc 1 Real RW Calibration concentration
Device.name.OBC Conc 2 Real RW
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Name Type Read/
Write Notes

Device.name.OBC Conc 3 Real RW
Device.name.OBC Conc 4 Real RW

Device.name.OBC Prop Gain 1 Real RW Proportional gain
Device.name.OBC Prop Gain 2 Real RW
Device.name.OBC Prop Gain 3 Real RW
Device.name.OBC Prop Gain 4 Real RW

Device.name.OBC Integ Gain 1 Real RW Integral gain
Device.name.OBC Integ Gain 2 Real RW
Device.name.OBC Integ Gain 3 Real RW
Device.name.OBC Integ Gain 4 Real RW

Device.name.OBC Min Control 1 Real RW Minimum control
Device.name.OBC Min Control 2 Real RW
Device.name.OBC Min Control 3 Real RW
Device.name.OBC Min Control 4 Real RW

Device.name.OBC Max Control 1 Real RW Maximum control
Device.name.OBC Max Control 2 Real RW
Device.name.OBC Max Control 3 Real RW
Device.name.OBC Max Control 4 Real RW

Device.name.OBC Sens 1 Real RW Calculated sensitivity
Device.name.OBC Sens 2 Real RW
Device.name.OBC Sens 3 Real RW
Device.name.OBC Sens 4 Real RW

Device.name.OBC SetPt  1 Real RW PI controller conc. set point
Device.name.OBC SetPt  2 Real RW
Device.name.OBC SetPt  3 Real RW
Device.name.OBC SetPt  4 Real RW

Channels.name Real R Measured concentration
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Commands

*		Indicates	a	required	parameter.

Function: 21 Concentration Enable

Sets	the	concentration	value	and	enables	or	disables	concentration	calculations	
for	the	specified	channel.		If	only	the	channel	is	supplied,	the	current	settings	are	
returned.

Parameters

*Channel a number between 0 and 32, the channel to enable.
State  0 to disable, 1 to enable.
Concentration Value the calibration concentration value

Returns

If	a	state,	or	state	and	concentration,	are	supplied	and	the	command	is	success-
ful,	an	acknowledge	response	(‘A’)	is	returned.		If	not	successful,	an	error	code	
is	returned.		If	no	value	is	supplied,	the	current	state	of	0	or	1	and	the	calibration	
concentration	value	for	the	channel	is	returned.

Examples

	 Command
For Dymaxion at address 01, set channel 0 concentration enable to 1 (enabled) 
and the concentration value to 50.00.

	 >01210	1	50.00??
	 Response
	 A



OBC Software   |   A-11

Function: 22 Concentration Sensitivity

Sets	the	concentration	sensitivity	for	the	specified	channel.		If	only	the	channel	is	
supplied,	the	current	settings	are	returned.

Parameters

*Channel a number between 0 and 32, the channel to enable.
Value  A floating point number to set the sensitivity to.

Returns

If	a	value	is	supplied	and	the	command	is	successful,	an	acknowledge	response	
(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		If	no	value	is	sup-
plied,	the	current	value	of	the	concentration	sensitivity	value	for	the	channel	is	
returned.

Function: 23 Concentration Background

Sets	the	concentration	background	value	for	the	specified	channel.

Parameters

*Channel a number between 0 and 32, the channel to enable.
Value  A floating point number to set the background to.

Returns

If	a	value	is	supplied	and	the	command	is	successful,	an	acknowledge	response	
(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		If	no	value	is	sup-
plied,	the	current	value	of	the	concentration	background	value	for	the	channel	is	
returned.
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Function: 24 Configure Analog Output 0

Configure	analog	output	0	parameters	of	the	I/O	Option	board.

Parameters

*Channel a number between 0 and 32, the channel to enable.
Enable 1 to enable, 0 to disable
Zero The value to use as the 0 value for current output calculations
Full The value to use for the full scale during current output calculations

	 Returns

If	enable,	zero	and	full	values	were	sent	and	the	command	is	successful,	an	ac-
knowledge	response	(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		
If	no	optional	values	are	supplied,	the	current	setting	for	analog	output	0	of	the	
channel	is	returned.

Examples

	 Command
	 For Dymaxion at address 01, set channel 0 analog output 0 enable to 1 (en-

abled), the zero value to 0 and the full scale value to 100.

	 >01240	1	0	100??
	 Response
	 A

Function: 25 Concentration High Alarm

Configure	concentration	high	limit	value	and	specify	digital	output	of	the	I/O	Op-
tion	board	to	be	set	if	the	concentration	limit	is	exceeded.

Parameters

*Channel a number between 0 and 32, the channel to enable.
Enable Which digital output to enable if the concentration level is 

exceeded for the channel; 0 to disable.
High Limit Value A floating point number for the concentration limit.
Full The value to use for the full scale during current output calcu-

lations
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Returns

If	enable,	or	enable	and	a	value,	were	sent	and	the	command	is	successful,	an	ac-
knowledge	response	(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		
If	no	optional	values	are	supplied,	the	current	digital	output	and	high	alarm	limit	
for	the	channel	are	returned.

Examples

	 Command
	 For Dymaxion at address 01, using channel 0 for the value, set digital output 

1 if concentration of channel 0 exceeds 50.0.

	 >01250	1	50.0??
	 Response
	 A

Function: 26 Concentration Low Alarm

Configure	concentration	low	limit	value	and	specify	digital	output	of	the	I/O	Op-
tion	board	to	be	set	if	concentration	limit	exceeded.

Parameters

*Channel a number between 0 and 32, the channel to enable.
Enable Which digital output to enable if the concentration level is 

exceeded for the channel; 0 to disable.
Low Limit Value A floating point number for the concentration limit.

Returns

If	enable,	or	enable	and	a	value,	were	sent	and	the	command	is	successful,	an	ac-
knowledge	response	(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		
If	no	optional	values	are	supplied,	the	current	digital	output	and	low	alarm	limit	
for	the	channel	are	returned.

Examples

	 Command
	 For Dymaxion at address 01, using channel 0 for the value, set digital output 

1 if concentration of channel 0 drops below 50.0.

	 >01260	1	50.0??
	 Response
	 A
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Function: 27 Read Concentration
Read	the	concentration	value	for	a	specified	channel.

Parameters

*Channel the channel to read the concentration value for

Returns

A	concentration	value	for	the	given	channel.		If	not	successful,	an	error	code	is	
returned.

Examples

	 Command
	 For Dymaxion at address 01, read the concentration for channel 0.

	 >01270??
	 Response
	 A49.98??

Function: 28 Concentration Calibration

Read	the	concentration	value	for	a	specified	channel.

Parameters

Calibrate a number between 0 and 3 
0 is normal operation (not calibrating)
1 is background calibration
2 is sensitivity calibration 
3 is a manual calibration.

Returns

If	a	valid	calibration	type	is	sent	and	the	command	is	successful,	an	acknowledge	
response	(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		If	no	optional	
values	are	supplied,	the	current	calibrating	value	is	returned.
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Examples

	 Command
	 For Dymaxion at address 01, initiate a manual calibration.

	 >01283??
	 Response
	 A

Function: 29 Concentration Calibration Status

Read	the	concentration	calibration	status.

Parameters

None

Returns

The	current	calibration	status	is	returned.		

0 the calibration was successful 

1 a calibration is required

10 calibration failed due to the filament off or system error

11 calibration failed due to no concentration channels defined

12 calibration failed because the background is too small or the calibra-
tion concentration is zero

13 calibration failed because the concentration value is too small or zero

Examples

	 Command
	 For Dymaxion at address 01, read the concentration calibration status.

	 >0129??
	 Response
	 A020
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Function: 2A Concentration Calibration Average

Set	the	number	of	readings	to	average	during	concentration	calibration.

Parameters

Number of Readings number of readings to average during concentration 
calibration

Returns

If	a	valid	calibration	average	is	sent	and	the	command	is	successful,	an	acknowl-
edge	response	(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		If	no	
optional	values	are	supplied,	the	current	calibration	average	value	is	returned.

Examples

	 Command
	 For Dymaxion at address 01, average 5 readings for concentration calibration.

	 >012A5??
	 Response
	 A

Function: 2B Concentration Smoothing Filter

Set	the	smoothing	factor	for	concentration	calculations.		

Parameters

*Channel the channel number
Smoothing
Factor

This factor is used in an exponential smoothing algorithm to the 
concentration value to reduce noise. It will also reduce response 
time to fast changes in concentration.  

The smoothing weight value can range between 0.01 to 1.0. A 
weight of 0 or 1.0 will disable smoothing. Weights between 0.1 
(more smoothing) and 0.9 (less smoothing) work best. A weight 
of 0.2 works well.

Returns

If	a	valid	smoothing	factor	is	sent	and	the	command	is	successful,	an	acknowl-
edge	response	(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		If	no	
optional	values	are	supplied,	the	current	smoothing	filter	value	is	returned.
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Examples

	 Command
	 For Dymaxion at address 01, channel 0, set the smoothing factor to 0.5.
	 >012B0	0.5??
	 Response
	 A

Function: 2C Filament Status Output

Set	which	digital	output	to	trigger	for	a	filament	status	change.

Parameters

Output the digital output to set when the filament fails

Returns

If	a	valid	output	is	sent	and	the	command	is	successful,	an	acknowledge	response	
(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		If	no	optional	values	
are	supplied,	the	current	output	being	used	is	returned.

Examples

	 Command
	 For Dymaxion at address 01, set digital output 3 if the filament fails.

	 >012C3??
	 Response
	 A

Function: 2D System Status Output

Set	which	digital	output	to	trigger	for	a	system	status	change.

Parameters

Output the digital output to set when a system status error is generated
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Returns

If	a	valid	output	is	sent	and	the	command	is	successful,	an	acknowledge	response	
(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		If	no	optional	values	are	
supplied,	the	current	output	being	used	is	returned.

Examples

	 Command
	 For Dymaxion at address 01, set digital output 3 if a system status error is 

generated.

	 >012D3??
	 Response
	 A

Function: 2E Save and Restore Configuration

Saves	or	restores	the	current	system	configuration.		There	are	two	sets	of	configu-
ration	parameters:	active	and	backup.		

•	 When	saving,	the	currently	saved	parameters	are	overwritten	with	the	active	
configuration.		

•	 When	restoring,	the	currently	saved	parameters	will	overwrite	the	active	
configuration.

Parameters

Option 1 to save the configuration
0 to restore

Returns

If	a	valid	option	is	sent	and	the	command	is	successful,	an	acknowledge	response	
(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		If	no	optional	val-
ues	are	supplied,	the	current	output	being	used	is	returned.
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Examples

	 Command
	 For Dymaxion at address 01, save the current configuration

	 >012E1??
	 Response
	 A

Function: 2F Set PI Control Parameters

Set	the	PI	control	parameters.

Parameters

*Channel the channel number
Proportional Gain the proportional gain term for PI control
Integral gain the integral gain term for PI control
Minimum Control 
Value

This is a percentage of full scale from 0 to 100. For example: 
to prevent a flow controller from turning off completely, you 
could set this to 5. The flow will never be set lower than 5% 
of full scale. 

Maximum Con-
trol Value

This is a percentage of full scale from 0 to 100, the maxi-
mum output that will be generated.

Returns

If	a	valid	option	is	sent	and	the	command	is	successful,	an	acknowledge	response	
(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		If	no	optional	val-
ues	are	supplied,	the	current	PI	control	parameters	are	returned.

Examples

	 Command
	 For Dymaxion at address 01, channel 0, set the proportional gain to 100, the 

integral gain to .01, the minimum control value to 5 and the maximum control 
value to 95.

	 >012F0	100	.01	5	95??
	 Response
	 A
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Function: 30 Set PI Setpoint

Sets	the	PI	controller	setpoint	for	the	given	channel

Parameters

*Channel the channel number
Setpoint the PI controller setpoint

Returns

If	a	valid	option	is	sent	and	the	command	is	successful,	an	acknowledge	response	
(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		If	no	optional	values	
are	supplied,	the	current	setpoint	being	used	is	returned.

Examples

	 Command
	 For Dymaxion at address 01, set channel 0 PI setpoint to 50

	 >01300	50??
	 Response
	 A

Function: 31 Set Auto Calibration Digital Input

Set	which	digital	output	to	trigger	for	a	system	status	change.

Parameters

Input the digital input to use to trigger an automatic calibration

Returns

If	a	valid	input	is	sent	and	the	command	is	successful,	an	acknowledge	response	
(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		If	no	optional	val-
ues	are	supplied,	the	current	input	being	used	is	returned.
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Examples

	 Command
	 For Dymaxion at address 01, start a calibration if input 1 is triggered.

	 >01311??
	 Response
	 A

Function: 32 Configure Analog Output 1

Configure	analog	output	1	parameters	of	the	I/O	Option	board.

Parameters

*Channel a number between 0 and 32, the channel to enable.
Enable 1 to enable; 0 to disable.
Zero Value to use as the 0 value for current output calculations
Full The value to use for full scale during current output calculations

Returns

If	enable,	zero,	and	full	values	were	sent	and	the	command	is	successful,	an	ac-
knowledge	response	(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		
If	no	optional	values	are	supplied,	the	current	setting	for	analog	output	0	of	the	
channel	is	returned.

Examples

	 Command
	 For Dymaxion at address 01, set channel 0 analog output 1 enable to 1 (en-

abled), the zero value to 0 and the full scale value to 100.

	 >01240	1	0	100??
	 Response
	 A
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Function: 33 Enable OBC

Set	OBC	mode

Parameters

Mode 0 for normal mode; 1 for OBC

Returns

If	a	valid	input	is	sent	and	the	command	is	successful,	an	acknowledge	response	
(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		If	no	optional	val-
ues	are	supplied,	the	current	mode	is	returned.

Examples

	 Command
	 For Dymaxion at address 01, enable OBC mode.

	 >01331??
	 Response
	 A

Function: 34 Get OBC Data

Get	OBC	data.

Parameters

*Channel the channel number

Returns

The	current	ion	current	and	concentration

Examples

	 Command
	 For Dymaxion at address 01, get OBC data for channel 0.

	 >01340??
	 Response
	 A1.3E-10	32.5??
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Function: 35 Get OBC Data 2

Get	more	OBC	data.

Parameters

*Channel the channel number

Returns

The	current	values	for	the	two	analog	outputs	and	the	digital	output.

Examples

	 Command
	 For Dymaxion at address 01, get OBC data 2 for channel 0.

	 >01350??
	 Response
	 A1024	2048	1??

Function: 36 Enable Analog Outputs

Enable	the	analog	outputs.

Parameters

Enable Output 0 0 to disable; 1 to enable
Enable Output 1 0 to disable; 1 to enable

Returns

If	a	valid	input	is	sent	and	the	command	is	successful,	an	acknowledge	response	
(‘A’)	is	returned.		If	not	successful,	an	error	code	is	returned.		If	no	optional	val-
ues	are	supplied,	the	current	settings	are	returned.

Examples

	 Command
	 For Dymaxion at address 01, enable both analog outputs.

	 >0136	1	1??
	 Response
	 A
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Function: 37 Debug

Read	debugging	information.

Parameters

None

Returns

Factory	debug	information,	not	intended	for	customer	use.

Function: 38 Configure External Optomux

Configure	the	external	Optomux	settings.

Parameters

*Channel the external output channel to enable
Command Sending a ‘C’ clears all current channel information; all other 

parameters are ignored
Mode Future use. Should always be ‘A’
Enable Enable the external output channel.

1 to enable; 0 to disable
Channel The channel to use to calculate the value for theoutput
Address The address for the optomux analog output channel to be 

used
Module The module at the given address to use for the output
Low Value The value to be used for the zero value of the output
High Value The value to be used for the high value of the output

Returns

	 If	the	command	is	successful,	an	acknowledge	response	(‘A’)	is	returned.		If	
not	successful,	an	error	code	is	returned.		If	no	optional	values	are	supplied,	
the	current	setting	for	the	channel	is	returned.
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Examples

	 Command
	 For Dymaxion at address 01, set channel 0 of the external Optomux output 

as analog (‘A’), enable to 1 (enabled), use channel 0 of the scanning chan-
nels as the input, set the Optomux module address to 132, use module 4, set 
the low value to 0 and the high value to 100.

	 >01380	A	1	0	132	4	0	100??
	 Response

	 A
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 CONTROLLER /  USER INTERFACE

System Start-Up

1. Plug the power connector from a 24 VDC power supply into the  
power entry module on the front of the analyzer. 

2. If you are using an AMETEK 24 VDC power supply (PN:25469JE), plug 
the cord of the power supply into the appropriate AC power outlet. 

NOTE


Once you have plugged into the power source, the analyzer will be 
ON. Manually disconnecting the power source will turn the analyzer 
OFF. There is no manual On/Off switch or button.

3. Run either the cal gas or sample gas through the instrument.
4. Allow the analyzer to warm up for one hour. 
5. Set up your alarms, analog and digital outputs, and PC and device 

communications using CG1102 system configurator software. See 
instructions in this chapter.

6. If you are running a cal gas initially, check the O2 reading by clicking 
on the software Status tab. If the reading is correct, proceed with run-
ning the sample gas.

7. If there is an error in the O2 reading, perform a calibration operation 
(Chapter 5).

8. If you are running a sample gas initially, read the sample gas.

Setting up System Parameters

Use the configurator software’s graphical user interface to set up your 
analyzer(s). Though you can use the configurator software to set up multiple 
analyzers, you can only view the status of a single analyzer at a time. If using the 
System 2000 software, refer to the System 2000 manual.

PC Requirements for Configurator Software

• Microsoft Windows 98, NT 4.0 2000 or XP
• 640 x 480, 256-color display

Make sure that your system is set 
up properly with sample gas flow 
and cal gas flow valves attached. 
For instructions on how to set 
up your system, see Mechanical 
Installation in Chapter 3. 
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Configurator Software Installation

1. Insert the Setup Disk 1 into your floppy disk drive.

2. Choose RUN . . . from the Windows Start Menu.

3. Type the drive letter, followed by a colon(:) and a backslash (\) and the word 
“setup.”

Example:   a:\setup

4. Follow the instructions on your screen. Click Next to continue the Setup 
process.
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Configuring Your Device

General Tab
Defines device and communications settings .

Figure 4-1.
General tab configurator software.

Device
Name Provides a name for the device.
Description Provides optional description information.
Save Con-
figuration

Saves analyzer internal parameters to a file. The Save As 
dialog box will appear so that you can name the file.

Restore 
Configura-
tion

Restores analyzer internal parameters from a file. The 
Open dialog box will appear so that you can open the file. 
This button can be used for emergency recovery.

Live data 
check box

Not Checked System uses demonstration data.
Checked System uses live data from the analyzer.
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Figure 4-2.  Serial port configuration under PC Communication setup button.

PC communications
Setup Click the Setup button to set-up PC communications.

Port Select the COM port on the computer used to connect to 
you device.

Baud Rate Select the baud rate at which data will be transferred. 
(Either 9600 or 19200)

RS-232 Port Click if device is using the RS-232 communications port.
RS-485 Port Click if device is using the RS-485 communications port.
Address Type the network address of the device.

Device Communications Tab

Figure 4-3.  Device Communication tab for configurator

Baud rate Select the baud rate at which data will be transferred.
RS-485 Identifies the analyzer’s address and the type of serial com-

munication cable being used.
Address Type the network address for the device being connected.
2-wire RS-485 Click if device is using 2-wire serial cable.
4-wire RS-485 Click if device is using 4-wire serial cable.
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Setup Tab
Defines system parameter settings. 

Figure 4-4.  Setup tab  for configurator software.

Carrier gas Specify the sample gas stream being analyzed in the list box.

Flow

Enter the flow for the sample gas. 

If running your system at a flow rate other than 100 sccm, it 
will be necessary to recalibrate your system.  A higher flow 
rate will result in faster response and need a higher pressure 
differential between inlet and outlet pressure. A lower flow 
rate will result in a slower response and require a lower pres-
sure differential.

Concentration Define calibration settings.

Span

Enter span gas in percent or PPM. Initiate span gas. Check 
O2 reading on the Status tab  until O2 reading stabilizes. 
Then click the Calibration tab and then the Calibrate Span 
button .

Zero
Enter zero gas in percent or PPM. Initiate zero gas. Check O2 
reading on the Status tab  until O2 reading stabilizes. Then 
click on Calibration tab and then the Calibrate Zero button .
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Alarm Tab
Defines alarm settings. 

Figure 4-5a/b.   Alarm tab on configurator software.
Alarm output 1

Disabled Disable alarm.
Oxygen Enable oxygen alarm.
Flow Enable flow alarm.
Pressure Enable pressure alarm.
High limit Enter high limit value.
Low limit Enter low limit value.

Alarm output 2
Disabled Disable alarm.
Oxygen Enable oxygen alarm.
Flow Enable flow alarm.
Pressure Enable pressure alarm.

**CG1000** Enable CG1000 emulation. Limits must be set through
the  serial port.

High limit Enter high limit value
Low limit Enter low limit value
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Analog Tab
Defines analog output settings.

Figure 4-6 a/b.   Analog tab on configurator software.

Analog output selectable for oxygen, flow and pressure
Disabled Disable analog output.
Oxygen Enable oxygen analog output.
Flow Enable flow analog output.
Pressure Enable pressure analog output.
Full Scale Enter upper range output value.
Zero Enter lower range output value.
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Calibration Tab
Defines type of calibration. 

Figure 4-7.   Calibration tab. 

Span & zero Dual gas calibration. 
Click to calibrate on both span and zero gas.

Span only Single gas calibration. Click to calibrate span gas only.
Zero only Single gas calibration. Click to calibrate zero gas only.

Calibrate span Begins calibration for span gas. Button grays out when 
clicked and calibration is in process.

Calibrate zero Begins calibration for zero gas. Button grays out when 
clicked and calibration is in process.

Cancel/abort

Click on the Span & Zero in a dual calibration. 
Click on the Span Only or Zero Only on a single cali-
bration. 
The calibration will abort and the Calibrate button will 
no longer be grayed out. Also, you can click Cancel at 
the bottom of the screen to abort/cancel the calibration.

Last calibration Results of the last calibration indicating the reference 
gas value, last calibration value  and percent error.
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Verification Tab
Verify calibration readings based on percent error.

Figure 4-8.   Verification tab. 

Use span gas Click to verify the span gas.
Use zero gas Click to verify the zero gas.
Verify Click to begin verification.
Acceptable range Enter the acceptable error range value in percent.

Last verification Indicates results of last verification using the last 
reference, verification result and percent error.
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Status Tab
Indicates current reading and status of CG1102.  

Figure 4-9.   Status tab on configurator software.

Oxygen reading Current oxygen reading in percent.
Cell temperature Current temperature in degrees C.
Flow Current sample flow in sccm.
Pressure Current pressure in psig.

Error box Right below the analyzer status box (on-line) is a box 
that displays error messages.
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